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control systems, which includes computer software and may include associated media and documentation (including, e.g., print materials and on-line or electronic 

documentation) (collectively, the “Software”).  

GRANT OF LICENSE

Lutron grants to the End User a limited, nonexclusive, revocable license to use the Software subject to the terms and conditions herein.

LICENSE RESTRICTIONS

The End User may use the Software only on a single computer connected to a Grafik system, or a computer expressly approved and authorized by Lutron in 

writing.

The End User may transfer all of its rights under this License Agreement, along with the Software and the server, if any, on which the Software is installed to 

the purchaser of the real estate to which the lighting control system is affixed, provided that the other party agrees to be bound by the terms and conditions of 

this License Agreement.  Transfer of such rights automatically terminates the license of the transferor.  The End User may not sublicense, sell, rent or lease the 

Software to others, or otherwise transfer or assign the right to use the Software, except as stated in this paragraph.

The End User may not decompile, disassemble, reverse engineer, or in any way modify the Software without the prior written consent of Lutron, except and only 

to the extent that such activity is expressly permitted by applicable law, notwithstanding this provision.

OWNERSHIP OF SOFTWARE

The Software and any authorized copies made by the End User are the intellectual property of and are owned by Lutron and/or its suppliers. The structure, 

organization and code of the Software are the valuable trade secrets and confidential information of Lutron and/or its suppliers. The Software is protected by law, 

including without limitation the copyright laws of the United States and other countries, and by international treaty provisions. Except as expressly stated herein, 

this License Agreement does not grant the End User any intellectual property rights in the Software and all rights not expressly granted are reserved by Lutron and 

its suppliers.

APPLICABLE LAW

This Software License Agreement is governed by the laws of the Commonwealth of Pennsylvania.  The End User agrees to consent to the non-exclusive 

jurisdiction of the courts in Pennsylvania.

ENTIRE AGREEMENT

This License Agreement, including any addendum or amendment to the License Agreement which is included with the Software, the Grafik lighting control system 

warranty, and any applicable Lutron Services Co., Inc. service contract, are the entire agreement between the End User and Lutron relating to the Software, and 

they supersede all prior or contemporaneous oral or written communications, proposals and representations with respect to the Software or any other subject 

matter covered by this License Agreement.  To the extent the terms of any Lutron policies or programs for support services conflict with the terms of this License 

Agreement, the terms of this License Agreement shall control.  The terms of this License Agreement shall not be modified except by the consent of Lutron given in 

a writing signed by an officer of Lutron.

SEVERABILITY

If any of the provisions of this License Agreement are invalid under any applicable statute or rule of law, then those provisions or portions thereof are to that extent 

deemed to be omitted.
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Chapter 1
TERMINATION

Without prejudice to any other rights, Lutron may terminate this License Agreement if the End User does not abide by the terms and conditions of this License 

Agreement, in which case the End User must either destroy or return, at Lutron’s sole option, all copies of the Software and all of its component parts.

eLumenTM

Introduction
Welcome to eLumenTM software and to the worldwide Lutron customer family! Your new Lutron lighting control 
system will enhance the ambiance and elegance of your building, while providing you with an extraordinary suite 
of tools to design, monitor, and control your project.
Lighting design is an important part of a building project and a key element in managing the building for its users. 
Your new Lutron system enhances your building when you first open your doors, and your Lutron system can 
grow and change to provide you and your building users with the utmost in flexibility, convenience, and system 
management.

Overview
Lutron’s GRAFIKTM 5000, 6000, and 7000 systems control a wide range of projects from residences and 
restaurants to hotels, convention centers, theme parks, and office buildings. Some projects have modest design 
requirements - other projects require constant management and monitoring by a staff of dedicated building 
professionals. Whether the simplest system or the most sophisticated, your Lutron lighting control system 
is managed by a suite of applications named eLumen. eLumen software was developed with sophisticated 
technology to:
•  Design your system    –identifying spaces and zones, specifying scenes, creating schedules, programming events, 

and much more.
•  Monitor your system–reporting zone intensities, current scene selection, system status information, and much 

more.
• Control your system–selecting scenes, changing light levels, enabling or disabling controls, and much more.

eLumenTM Applications
The eLumen suite includes four standard applications: DesignITTM, ControlITTM, ConfigureITTM, and SecureITTM. You 

will use these tools to manage your Lutron lighting control system.
DesignITTM

Use the DesignIT application to add, change, or remove different parts of your project. You will use the DesignIT 
application to add additional spaces or zones, to change intensities in scenes, to program buttons, to schedule 
events, and much more. As a general rule, if you are changing data in your project, you will use the DesignIT 
application.

ControlITTM

Use the ControlIT application to monitor and control your lighting system. You can view (or change) current zone 
intensities, specify the scene to show in a space, and otherwise manage your system. You will also use the 
ControlIT application to compile and transfer any project changes you make with DesignIT to the GRAFIK 5000, 
6000, or 7000 processor(s) in your system.

SecureITTM

Use the SecureIT application to add users to your system, assign passwords for those users, and assign access 
rights and privileges to users. If your system is divided into multiple projects you can associate a user with some 
of those projects, but not necessarily all of them. 

ConfigureITTM

Use the ConfigureIT application to make real-time configuration changes to your scenes. You can modify zone 
intensity, fade time, and delay time. The ConfigureIT application also allows you to flash individual zones if you 
have trouble locating them in the space.

The eLumen suite offers additional software tools that are sold as system options to provide graphical floorplan 
control, to permit ad hoc scheduling of events, and other features. If you would like to explore adding options to 
your system, contact your Lutron sales representative for assistance, or call Lutron customer service at one of the 
phone numbers listed on page 5. 

C
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System Map

Building 

Management 

System

Client’s Local Area 
Network

eLumen Manager

Sivoia QED Shade

GP Dimming 
Panels

LP Dimming 
Panels

XP Switching 
Panels

Additional 
GRAFIK 7000P 
Processor(s) as 

needed

GRAFIK 7000P
Processor

Additional 
GRAFIK 7000P 
Processor(s) as 

needed

Wall Controls Wall Controls Wall Controls

Sample System
The following illustration shows a sample configuration for a GRAFIKTM 7000 lighting control system.
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System Maximums

GRAFIKTM 5000
• 1 GRAFIK 5000P processor
• 128 zones
• 2,048 circuits
• 64 dimming and/or switching panels
• 32 wallstations and/or interfaces

GRAFIK 6000®

• 1 GRAFIK 6000P processor
• 512 zones
• 4,000 circuits
• 125 dimming and/or switching panels
• 96 wallstations and/or interfaces

GRAFIKTM 7000
• 32 GRAFIK 7000 processors
• 16,384 zones
• 128,000 circuits
• 4,000 Lutron dimming and/or switching panels
• 6,144 wallstations and/or interfaces
• 1 eLumenTM Manager with RAID (Redundant Array Independent Disks)
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Creating a New Zone
A zone is a collection of switch legs controlled
simultaneously as one unit (also called a channel by
some lighting designers).

To create a new zone:
1.From the Navigator in the Logical Definition screen,

select the space to which the zone is to be added.

The Zones dropdown list in the top portion of the
main pane displays existing zones for that space.
The table in the lower portion of the main pane
displays settings for the currently selected zone.

2.Select the Zones panel in the Toolbox. Then click
and drag the Create New Zone option into the top
portion of the main pane.

The zone is added to the space. You can now
associate switch legs with the zone. You can also
add zones to scenes.

NOTES:
• To rename the zone, refer to "Viewing and Editing

Object Properties" on page 11.
• To create more than one zone, click and drag the

Create Multiple New Zones option into the main
pane. Type the number you wish to add and click
the OK button.

Creating Switch Leg to Zone
Associations
Switch legs are associated with zones so that they
(and the loads they connect to) can be controlled
simultaneously through the zone.

To create a switch leg to zone association:
1.From the Navigator in the Logical Definition screen,

select the Zones folder below the space that is to
have the switch leg to zone association.

The Zones dropdown list in the top portion of the
main pane displays existing zones for that space.
The table in the lower portion of the main pane
displays settings for the currently selected zone.

2.From the Zone dropdown list, select the zone.

3.Select the Switch Legs panel in the Toolbox. Then
click and drag the appropriate switch leg into the
top portion of the main pane or directly onto the
zone row in the table (the row will highlight when the
cursor is over it).

click and drag

click and drag

Major Topic

Specific Task

Procedures 

include screen 

shots parallel to 

the corresponding 

text showing the 

current task with 

helpful arrows 

guiding the way

Words defined in 

the Lexicon are 

italicized

Using Your Manual
This manual was designed to help you use eLumenTM to manage your Lutron lighting control system. The manual 
is divided into chapters. Each chapter contains several major topics and each major topic may have one or more 
specific tasks. Screen shots and pictures of icons are frequently used to show you how each task can be performed.

Please take note of the following special features:
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 Additional Help
This manual includes several additional features to help you get the most advantage from your Lutron lighting control 
system.

• Lexicon: defines many of the terms used throughout the manual. See page 80
•  Frequently Asked Questions (FAQ): lists questions that the user community has asked, with references to 

appropriate tasks in this manual. See page 6
• Index: used to find specific information on a wide range of topics. See page 84
•  Online help: Each application provides useful, practical information at your fingertips as you work with the software.

Lutron Technical Support
Every Lutron lighting control system shipped includes an invaluable feature: the men and women of Lutron Technical 
Support, who are available 24 hours per day, 7 days per week, to help you with any issue. Our Technical Support 
staff can help you with any problem you might encounter - and they can provide helpful suggestions about how to 
best take advantage of your system.

 
www.lutron.com

Lutron Electronics Co., Inc.
7200 Suter Road
Coopersburg, PA 18036-1299

World Headquarters +1.610.282.3800
Customer Support 1.888.LUTRON1

Technical Support Centers
 United States, Canada and the Caribbean: 1.800.523.9466 
 United Kingdom and Europe: +44.(0)20.7680.4481 
 Northern China: 10.800.712.1536
 Southern China: 10.800.120.1536
 Hong Kong: 800.901.849
 Japan: +81.3.5575.8411
 Singapore: 800.120.4491
 Taiwan: 00.801.137.737
 Thailand: 001.800.120.665853
 Other countries: +800.120.4491
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Frequently Asked Questions
New to the current version of eLumenTM software is a Welcome Screen that addresses some of the most 
commonly performed tasks and a quick guide to performing each task.

The documentation uses a word or phrase I have never seen before.
See “Lexicon” on page 80.

How do I change my preset lighting scenes?
See “Changing a Preset Lighting Scene” on page 23.

How do I change when my time clock event happens?
See “Changing When a Time Clock Event Happens” on page 46.

How do I change what my time clock does?
See “Changing What the Time Clock Event Does” on page 46.

How do I create a new time clock? 
See “Creating a New Time Clock” on page 25.

How do I change the function of my wall controls?
See “Programming a Button for a Single Action” on page 35.
See “Programming a Button for a Dual Action” on page 37.
See “Programming a Button for a Conditional Action” on page 38.

How do I add a new circuit or switch leg?
See “Adding a Switch Leg” on page 19.

How do I transfer settings to the system (processor)?
See Chapter 7 “Compile and Transfer” on page 71.

How do I change my username and password?
See “Resetting a User’s Password” on page 51.

How do I control my lighting zones?
See “Viewing and Setting Zone Intensities” on page 57.

How do I disable a control station device?
See “Viewing and Setting the State of Programmable Devices” on page 59.

How do I save scene changes?
See “To Run the Scene Capture Macro” on page 62.

How do I rename my zones/scenes/spaces?
See “Viewing and Editing Object Properties” on page 10.

How do I backup my database?
See Chapter 6 “Backup, Restore, and Update Tool” on page 69.    

 
Why can’t I see my project in any of my applications?
See “Associating Users with Projects” on page 50.
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Chapter 2

The Design IT Framework

Menus Toolbar

Status bar

DesignITTM

Overview
The DesignIT application enables you to create and 
maintain a database that models the lighting control 
system in a facility. To set up the database, you:

•           Create a model of the facility, including defining
   spaces and partitionable spaces
• Create zones and associate switch legs
• Add hardware, including control station devices, 

lighting panels, and sensors
• Program control functions, including assigning 

scenes and defining button functionality
• Create schedules
• Create flexible programming strategies with 

controls, groups, modes, partitions, time clock 
scheduling (astronomic and real-time), and 
reference scheduling

  The database you create within the DesignIT 
application is used to automate the facility’s 
lighting control system.

 NOTE: The DesignIT application is not intended for 
real-time control. For real-time control, refer to 
Chapter 4: ControlITTM.

Performing Basic DesignITTM 

Operations
The following topics contain procedures used to 
perform basic DesignIT application operations.

Starting and Exiting DesignITTM 
To start DesignITTM:

1. Double-click the DesignIT icon  on the desktop. 
Or from the Start menu, choose Lutron 
Electronics>DesignIT. 

You are prompted to login.

2. Enter your user name and password. Then click OK.

The DesignIT application framework is displayed. It 
contains menus, a toolbar, and a status bar. When 
a DesignIT application screen is open, additional 
components are added to the framework.

 To exit DesignITTM: Choose Exit from the File 
menu.

C
hap

ter 2
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System
Definition Equipment Groups Programming

Logical
Definition

Addressing ModesWelcome!

Toolbox

Properties Box
Main Pane

Navigator

ToolbarOpening DesignITTM Screens
Eight main screens are available from the DesignIT 
application framework.

 To open a DesignIT screen: Click its icon in the 
toolbar.

Optionally, choose a screen from the View menu.

DesignITTM Screen Components
Each DesignIT application screen has the following 
common components.

   

NAVIGATOR
Shows existing projects you can access and 
enables you to navigate to spaces and other folders 
within a project.

TOOLBOX
Used to add objects to the project.

MAIN PANE
Used to add objects by dragging them here 
from the Toolbox. Can show lists of objects and 
interactive images of Lutron hardware.

PROPERTIES BOX
Used to view and modify properties of the currently 
selected item.



eLumenTM Software User Guide    9

Number in parentheses 

shows the total number 

of objects contained in 

the folder

Using the Navigator
The Navigator component in the DesignITTM 

application framework displays levels of database 
information through which you can navigate. The 
project folder is positioned on top, with object folders 
arranged hierarchically below it.

NOTE: The projects available to you in the Navigator 
depend on the system privileges associated with 
your user name. For details about user names, refer 
to Chapter 3: SecureITTM.

To open a folder and display its contents: Click 
the folder’s + sign 

 or simply double-click the folder.

The folder opens and displays the first sublevel 
within the navigational tree.
Continue to open folders until you reach the desired 
level of the selected project.
The number in parentheses following the folder name 
indicates the number of objects contained in the 
folder.

To close a folder and hide its contents: Click the 
folder’s - sign 

 or double-click the folder.
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Click in an editable 

field and then enter a 

new property value

Viewing and Editing Object Properties
The Properties box in the DesignIT application 
framework shows property values for the object 
that is currently selected (for example, the object’s 
name).
Editable property fields are white; non-editable fields 
are gray and their values cannot be modified from 
this screen.

To edit a property value for a selected object: 
Click in the property field and then enter the new 
value.

Deleting Objects
You can delete an object if it is no longer needed.

To delete an o   bject:
1. Select the object.

 Some objects are selected in the navigator (for 
example, projects or spaces). Others are selected 
from dropdown lists displayed in the top portion 
of the main pane (for example, control stations or 
groups).

2. Click  in the toolbar, or choose Delete from the 
Edit menu.

3. Click OK to confirm the deletion. (Or click Cancel to 
cancel the deletion.)

Removing Objects
You can remove an object that is associated with 
another object (for example, a switch leg associated 
with a panel).

To remove an object:
1. Select the object.

Associated objects are typically selected by clicking 
on the object when displayed in the lower portion of 
the main pane.

2. Click  in the toolbar, or choose Remove from the 
Edit menu.

3. Click OK to confirm the removal. (Or click Cancel to 
cancel the removal.)

NOTE: Removing an object only removes the 
association to another object. It does not delete the 
object.
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The System Definition Screen

Click here and 

then enter a 

new project 

name

Using the System Definition 
Screen
The System Definition screen is used to create a 
project and add spaces that represent the physical 
characteristics of a facility or building. This screen 
is also used to add control stations, control station 
devices, switch legs, and sensors.

Opening the System Definition Screen

To open the System Definition screen: Click  
in the toolbar or choose System Definition from the 
View menu.

From the System Definition screen, you can:
• Create projects
• Create spaces and partitionable spaces
• Add control stations and control station devices
• Add switch legs
• Add sensors

Creating a New Project
A project is a container that includes all the 
database modeling information for a lighting control 
system.

To create a new project: From the System 

Definition screen, click  in the toolbar, or choose 

New from the File menu.
A folder for the new project is displayed in the 
Navigator and assigned a default project name.

To rename the project: Select the project folder 

in the Navigator. In the Properties box, click in the 

Name value field and then enter the name you 

would like to use. 
Once a project is created, you can add spaces and 
other objects to it.
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Sample office

building space

hierarchy

click and drag

Creating Spaces
A space refers to the physical representation of a 
building or any of its parts. Spaces can contain other 
spaces (subspaces). Spaces can also contain other 
objects (for example, control stations, sensors, and 
so on).
Adding spaces to a project or other spaces enables 
you to create an accurate representation of the 
building or facility to be modeled. For example, a 
typical office building could be modeled as shown on 
the right.
Spaces can be fixed (their walls do not move) or 
partitioned (have one or more movable walls that can 
be positioned to divide the space into subspaces).
Once spaces are created in the database, you can 
add objects to them.

Creating a New Fixed Space
Fixed spaces have fixed walls and cannot be 
partitioned.

To create a new fixed space:
1. From the System Definition screen, select the 

project in the Navigator. Or, to create a space within 
a space, select an existing space within the project.

Existing spaces, if any, for the selected project or 
space are listed in the main pane.

2. Select the Spaces panel in the Toolbox. Then click 
and drag the Create New Space option into the 
main pane.

NOTE: To create more than one space, click and 
drag the Create Multiple New Spaces option into the 
main pane. Type the number you wish to add and 
click the OK button.

The new space is displayed in the Navigator and 
assigned a default name. Folders for control 
stations, switch legs, and sensors are also 
automatically displayed for the space.
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NOTE: Other folders exist within the project and 
space. These folders for other object types are 
visible only on the screens in which they can be 
modified.

To rename the space:
1.Select the space in the Navigator.

2.In the Properties box, click the Name value field and 
then enter the name you would like to use.

NOTE: For partitionable spaces you must open the 
Partitionable Space Edit field to rename spaces. 
Right-click on the name of the space.
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Creating a New Partitionable Space
Partitionable spaces can have movable walls used 
to partition the space (create subspaces). Lights in 
partitionable spaces can be controlled differently 
depending on the state of the movable walls.
To create a new partitionable space:

1. From the System Definition screen, select the 
project in the Navigator. Or, to create a space within 
a space, select an existing space within the project.

Existing spaces, if any, for the selected project or 
space are listed in the main pane.

2. Select the Spaces panel in the Toolbox. Then click 
and drag the Create New Partitionable Space option 
into the main pane.

The Partitionable Space Designer opens and enables 
you to model the space, including fixed and movable 
walls.

NOTES:
•  To create more than one partitionable space, click 

and drag the Create Multiple New Partitionable 
Spaces option into the main pane. Type the 
number you wish to add and click the OK button.

•  The Partitionable Space Designer can also be used 
later to modify the space as needed. 

Legend
1. Normal Tool. Used to select, move, and highlight 

objects.

2. Fixed Wall Tool. Used to draw fixed walls in the 
partitionable space; this can be used to draw straight                 
lines or rectangles.

3. Moveable Wall Tool. Used to draw moveable walls in 
the space.

4. Text Tool. Used to add descriptive text to the diagram.

5. Delete Symbol Tool. Used to delete objects in the 
graphic.

6. Show / Hide Grid. Shows or hides the grid (the red 
dots); the grid is visible only in the DesignIT editor.

7. Add Space. Adds a new subspace to the partitionable 
space.

8.  Add Wall State. Adds a new wall state to an existing 
wall.

9. Add Wall. Adds a new wall to the partitionable space

10. Delete. Deletes objects from the project (walls, spaces, 
wall states).

11. Draw Region. The area in which the user draws the 
partitionable space layout.

12. Explorer Tree. Used to show the spaces and walls in 
the partitionable space. Right-click on any object and 
rename it from the tree.

13. Feedback Bar. Displays the properties of an object 
when you place the cursor over the object in the  
 graphic.

14. Template Object Properties. Used to change 
properties related to wall templates.

15. Add Wall to DB. Inserts a movable wall in the graphic 
into the database. There may be cases when you do 
not want to do this (associating a wall with an existing 
wall). By un-checking this option, you can draw a wall 
in the graphic without having to add it to the database.
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To use the Partitionable Space Designer:
1. To create a fixed wall, select the Fixed Wall tool. 

Then click the grid points to draw the shape of the 
space.

Click the start and end points to create a line. 
Double-click the final point to complete the shape.

2. To create a partition, select the Moveable Wall tool. 
Then click the grid points to draw the shape of the 
space.

Click the start and end points to create a line. 
Double-click the final point to complete the shape.

3. When you are finished modeling the space, click the 
Close button.

The new partitioned space is displayed in the 
Navigator and an image of the space is shown in 
the main pane. Edit Space and View Space buttons 
are also added to the main pane.

 Folders for control stations, switch legs, and sensors 
are also automatically created for the space.

To continue modeling the space, click the Edit 
Space button. 
To view the space in a separate window and view 
more details, click the View Space button. 
To rename the space, click the Edit Space button. 
From the navigation tree in the Partitionable Space 
Designer, right-click on the space name. Select 
Rename from the popup menu and then enter a new 
name. 

NOTE: Partitioned spaces cannot be renamed using 
the Properties box.
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click and drag

Converting a Fixed Space to a Partitionable 
Space
An existing fixed space can be converted 
automatically to a partitionable space.

To convert a fixed space to a partitionable 
space:

1. From the System Definition screen, select the fixed 
space in the Navigator.

2. Select the Spaces panel in the Toolbox. Then click 
and drag the Convert to Partitioned Space option 
into the main pane.

The space is converted and Edit Space and View 
Space buttons are displayed at the top of the main 
pane.

• To model the partitionable space, click the Edit 
Space button. Then use the Partitionable Space 
Designer to draw the model. 

• To view the partitionable space in a separate window 
showing additional details, click the View Space 
button. 

Note that there are two instances in which you 
cannot convert a fixed space to a partitionable 
space:

• The space to be converted cannot have more than 
one level of subspaces. For example, in the sample 
project shown below, Space A cannot be converted 
because it has a subspace called Space B, which 
in turn has a subspace called Space C. You could 
convert either Space B or Space C because they do 
not have more than 1 level of subspaces.

• A fixed space cannot be converted to a partitionable 
space if one of its subspaces is already partitioned. 
For example, in the sample project, if Space C was 
partitioned you could not convert Space B to a 
partitionable space.
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Converting a Partitioned Space to a Fixed Space
An existing partitioned space can be converted 
automatically to a fixed space. Movable walls are 
automatically deleted.
To convert a partitioned space to a fixed space:

1. From the System Definition screen, select the 
partitioned space in the Navigator.

The image of the partitioned space is displayed in 
the main pane.

2. Select the Spaces panel in the Toolbox. Then click 
and drag the Convert to Non-Partitioned Space 
option into the main pane.

The space is converted and the space image is 
removed from the screen. Since the space is no 
longer partitionable, the Edit Space and View Space 
buttons are also removed.

Adding a New Control Station
A control station refers to the wallbox used to house 
the control station device. Control stations are 
added to spaces as needed to model the lighting 
system.

To add a control station to a space:
1. From the System Definition screen, select the space 

in the Navigator.

The Control Stations dropdown list in the top portion 
of the main pane displays the existing control 
stations for that space.

2. Select the Control Stations panel in the Toolbox. 
Then click and drag the Create New Control 
Stations option into the main pane.

A control station is added to the space. Devices can 
now be added to the control station.

NOTES:
•  To rename the control station, refer to “Viewing 

and Editing Object Properties” on page 10.
•  To create more than one control station, click and 

drag the Create Multiple New Control Stations option 
into the main pane. Type the number you wish to 
add and click the OK button.
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Adding a Control Station Device
A control station device is housed in a control 
station and provides a point of input or output (for 
example, the buttons in a wall-mounted control). 
Devices are added to control stations as needed to 
model the lighting system.

To add a device to a control station:
1. From the Navigator in the System Definition screen, 

select the Control Stations folder for the space in 
which the control station is located.

The Control Stations dropdown list in the top portion 
of the main pane displays the existing control 
stations for that space.

2. Select the control station from the dropdown list.

3. Select the Control Station Devices panel in the 
Toolbox. Then click and drag the base model 
number of the device to be added into the main 
pane.

The device will be added to the control station 
and an interactive image of the hardware will be 
displayed.

NOTES:
•  To remove a control station device from the control 

station, select the device image in the main pane. 
Then select Remove from the Edit menu.

 •  Control station devices are programmed using the 
Programming screen.

Adding a Sensor
Sensors are devices that control lighting by 
detecting infrared (IR) signals, the current light level 
in the space, or whether the space is occupied. 
Sensors are added to spaces as needed to model 
the lighting system.

To add a sensor:
1. From the Navigator in the System Definition screen, 

select the space to which the sensor is to be added.

2. Select the Sensors panel in the Toolbox. Then click 
and drag an infrared (IR), photo, or occupancy 
sensor into the main pane.

The sensor is added to the space.

NOTES:
•  To rename the sensor, refer to “Viewing and 

Editing Object Properties” on page 10.
•  To create more than one sensor, click and drag 

the Add Multiple Sensors option into the main 
pane. Type the number you wish to add and click 
the OK button.

•  Sensors are associated with Lighting Zone 
Controller units using the addressing screen.
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Adding a Switch Leg
A switch leg is the connection between a group 
of loads and a switch leg control. Switch legs are 
added to spaces as needed to model the lighting 
system.

To add a switch leg to a space:
1. From the Navigator in the System Definition screen, 

select the space to which the switch leg is to be 
added.

2. Select the Switch Legs panel in the Toolbox. Then 
click and drag the Create New Switch Leg option 
into the main pane.

The switch leg is added to the space.

NOTES:
•  To rename the switch leg, refer to “Viewing and 

Editing Object Properties” on page 10.
•  To create more than one switch leg, click and drag 

the Create Multiple New Switch Legs option into 
the main pane. Type the number you wish to add 
and click the OK button.

•  Switch legs are associated with zones using the 
Logical Definition screen. If this switch leg is to 
be controlled individually, create a new zone and 
associate this switch leg to it. If the switch leg is to 
be controlled with others, associate the switch legs 
together on one zone.

•  Switch legs are associated with lighting panels and 
high voltage control units, known as switch leg 
controls, using the Equipment screen. Each switch 
leg will be associated with the output number of 
one of the switch leg controls.

Using the Logical Definition Screen
The Logical Definition screen is used to add zones, 
scenes, time clocks, and variables to a space or 
project.

Opening the Logical Definition Screen
To open the Logical Definition screen: Click  in 
the toolbar or choose Logical Definition from the 
View Menu.

 From the Logical Definition screen, you can:
• Create zones
• Create switch leg to zone associations
• Create scenes
• Create variables
• Create time clocks
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Creating a New Zone
A zone is a collection of switch legs controlled 
simultaneously as one unit (also called a channel by 
some lighting designers).

To create a new zone:
1. From the Navigator in the Logical Definition screen, 

select the space to which the zone is to be added.

The Zones dropdown list in the top portion of the 
main pane displays existing zones for that space. 
The table in the lower portion of the main pane 
displays settings for the currently selected zone.

2. Select the Zones panel in the Toolbox. Then click 
and drag the Create New Zone option into the top 
portion of the main pane.

The zone is added to the space. You can now 
associate switch legs with the zone. You can also 
add zones to scenes.

To rename the zone: Select the zone in the 
Navigator. In the Properties box, click in the Name 
value field and then enter the name you would like 
to use.

NOTE: To create more than one zone, click and 
drag the Create Multiple New Zones option into the 
main pane. Type the number you wish to add and 
click the OK button.

Creating Switch Leg to Zone 
Associations
Switch legs are associated with zones so that they 
(and the loads they connect to) can be controlled 
simultaneously through the zone.

To create a switch leg to zone association:
1. From the Navigator in the Logical Definition screen, 

select the Zones folder below the space that is to 
have the switch leg to zone association.

The Zones dropdown list in the top portion of the 
main pane displays existing zones for that space. 
The table in the lower portion of the main pane 
displays settings for the currently selected zone.

2. From the Zone dropdown list, select the zone.

3. Select the Switch Legs panel in the Toolbox. Then 
click and drag the appropriate switch leg into the 
top portion of the main pane or directly onto the 
zone row in the table (the row will highlight when the 
cursor is over it).
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NOTE: If All Zones is selected in the Zones 
dropdown list, the switch leg is associated with the 
zone that is currently selected in the table. To make 
the association with a different zone, click and drag 
the switch leg directly onto the row for the desired 
zone in the table.

The switch leg to zone association is created and 
default switch leg settings are displayed. You can 
now manually define the load for the switch legs in 
the zone.

To manually define the load for a switch leg:
1. From the table in the main pane, select the switch 

leg whose load you want to define. 

2. Select the Loads panel in the Toolbox. Then click 
and drag the Define Load Manually option into the 
main pane and directly onto the row for the switch 
leg in the table. (The row will highlight when the 
cursor is positioned over it.)

An editable row showing default load settings is 
added beneath the switch leg in the table. You can 
modify the settings, as needed.

3. To rename the load, click in the Fixture Circuit Name 
field and enter a new name.

4. To change the load type, click in the Load Type 
field and then select the option you want from the 
dropdown list.

5. To modify the other load settings, click in each of 
the fields and enter a new value. Move from left to 
right across the fields in the table row.
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Creating a New Scene
A scene is a lighting effect achieved by adjusting 
one or more zones to preset levels.

To create a new scene:
1. From the Navigator in the Logical Definition screen, 

select the Scenes folder below the space that is to 
have the scene.

The Scene dropdown list in the top portion of the 
main pane displays existing scenes for that space. 
The table in the lower portion of the main pane 
displays settings for the currently selected scene.

2. Select the Scenes panel in the Toolbox. Then click 
and drag the Create New Scene option into the top 
portion of the main pane.

The scene is added and displayed in the Scenes 
dropdown list in the top portion of the main pane. 
Empty fields for scene values are also displayed.

NOTES:
•  To rename the scene, refer to “Viewing and Editing 

Object Properties” on page 10.
•  To create more than one scene, click and drag the 

Create Multiple New Scenes option into the main 
pane. Type the number you wish to add and click 
the OK button.

To add a zone to the scene:
1. From the Scene dropdown list in the main pane, 

select the scene to which you want to add a zone. 

2. Select the Zones panel in the Toolbox. Then click 
and drag the zone to be added into the top portion 
of the main pane.

The zone is associated with the scene and default 
settings for the zone are displayed in the table in the 
main pane.

To remove a zone from the scene:
1.From the Scene dropdown list in the main pane, 

select the scene from which you want to remove a 
zone.

2.Select the zone that you would like to remove from 
the table in the lower center of the main pane.

3.Click on the remove icon  in the menu bar to 
remove the zone from the scene.
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Changing a Preset Lighting Scene
A scene is a lighting effect achieved by adjusting one 
or more zones to preset levels.

To select a scene to edit:
   From the Navigator in the Logical Definition screen, 

select the Scenes folder below the appropriate 
space.

The Scene dropdown list in the top portion of the 
main pane displays existing scenes for that space. 
The table in the lower portion of the main pane 
displays zone settings for the currently selected 
scene.

NOTE: To rename the scene, refer to “Viewing and 
Editing Object Properties” on page 10.

To change scene settings for an individual zone:
   To modify the scene settings, enter the Level, 

Fade and/or Delay moving from left to right, in the 
appropriate field for each zone.

NOTE: Alternatively, to set the level, use the slider to 
set the value in the Level field.

To change scene settings for multiple zones:
1.Select multiple zones by holding the CTRL key and 

clicking on each zone or by clicking on the first zone 
and then hold the Shift key while clicking on the last 
zone.  

2.To modify the scene settings for the selected zones, 
enter the Level, Fade and/or Delay in the fields at the 
bottom of the table.

NOTE: Alternatively, to set the level for all zones, use 
the ALL slider to set the value in the Level fields.
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Creating New Variables
A variable is a user-created object used for 
programming purposes. A variable can be one 
of three types: True/False, Multi-state, or Integer. 
Variables are added at the project level.
Example: A variable named “[spacename] occupied” 
could be created and the variable states could be 
True and False. This variable could then be used to 
program a button to either turn the lights OFF or dim 
them to a very low level.

To create a new variable:
1. From the Navigator in the Logical Definition screen, 

select the Variables folder below the project folder.

The Variables dropdown list in the top portion of the 
main pane displays existing variables for that space. 
The table in the lower portion of the main pane 
displays settings for the currently selected variable.

2. Select the Variables panel in the Toolbox. Then click 
and drag the Create New Variable option into the 
main pane.

The variable is added to the project and displayed in 
the dropdown list in the main pane.

NOTES: 

•  To create more than one variable, click and drag 
the Create Multiple New Variables option into the 
main pane. Type the number you wish to add and 
click the OK button.

 •  To rename the variable, refer to “Viewing and 
Editing Object Properties” on page 10.

To create a state for the variable:
1. Select the variable from the Variable dropdown list.

2. Select the Variable States panel in the Toolbox. Then 
click and drag the Create New Variable State option 
into the main pane.

The variable state is created and its default settings 
are displayed in the table.

3. To modify the variable state settings, enter the name 
and value in the fields provided.

NOTES:
•  To create more than one variable state, click and 

drag the Create Multiple New Variables States  
option into the main pane. Type the number you 
wish to add and click the OK button.

•  Variables are used later in the Programming 
screen.
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Creating a New Time Clock
A time clock is a collection of schedules. Time 
clocks can be added to the project or a space.

To create a new time clock:
1. From the Navigator in the Logical Definition screen, 

select the Time Clock folder for the project or space.

2. Select the Time Clock panel in the Toolbox. Then 
click and drag the Create New Time Clock option 
into the main pane.

The time clock is added to the project or space.

3.Events can now be created for your time clock. 
These programming functions can be accomplished 
on the Programming Screen. Please see “Working 
with Schedules and Time Clocks” on page 40 for 
more information.

NOTES:
•  To rename the time clock, refer to “Viewing and 

Editing Object Properties” on page 10.
•  Time clocks are programmed from the 

Programming screen.

Using the Equipment Screen
The Equipment screen is used to add processors 
and panels to spaces in a project. This screen is 
also used to associate all the switch legs in the 
lighting system with the switch leg controls in panels 
and high voltage control station devices (such as a 
GRAFIK Eye 3602).

Opening the Equipment Screen
To open the Equipment screen: Click  in the 
toolbar or choose Equipment from the View Menu.

 From the Equipment screen, you can:
• Add processors
• Add panels
•  Create switch leg to switch leg control 

associations
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Adding a Processor
A processor is a Lutron hardware device that 
communicates with other hardware via a series of 
links. A processor runs programs and maintains the 
state of all objects in the lighting system. Processors 
are housed in enclosures.

To add a processor:
1. From the Navigator in the Equipment screen, select 

the Equipment folder for the space in which the 
processor is located.

The Enclosure dropdown list in the main pane 
displays the existing enclosures, if any, for the 
space.

2. Select the Panels panel in the Toolbox. Then click 
and drag the base model number of the processor 
to be added into the main pane.

The processor is added to the space. The default 
name for the enclosure that houses the processor is 
displayed in the Enclosure dropdown list in the main 
pane. An image of the processor is also shown.

NOTES:
•  To rename the enclosure, select the enclosure 

from the dropdown list and then enter a new 
name in the Properties box. You can rename the 
processor on the Addressing screen.

•  Objects are added to links on the processor using 
the Addressing screen.

Adding a Panel
A panel is a factory built pre-wired assembly of 
hardware. Panels are housed in enclosures.

To add a panel:
1. From the Navigator in the Equipment screen, select 

the Equipment folder for the space in which the 
panel is located.

The Enclosure dropdown list in the main pane 
displays the existing enclosures, if any, for the 
space.

2. Select the Panels panel in the Toolbox and then click 
and drag the base model number of the panel into 
the main pane.

The panel is added to the space. The default name 
for the enclosure that houses the panel is displayed 
in the Enclosure dropdown list in the main pane. An 
image of the panel and a table for creating switch 
leg control associations is also displayed.

NOTE: To rename the enclosure, select the 
enclosure from the dropdown list and then enter 
a new name in the Properties box. To rename the 
panel, select the image and then enter a new name 
in the Properties box.

You can now associate a switch leg with each 
switch leg control on the panel.
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Creating a Switch Leg to Switch Leg 
Control Association
A switch leg control is any electronic device that 
controls a switch leg by varying the signal delivered 
to the load(s), including wallbox and panel-based 
switch leg controls. In most cases, a switch leg is 
located between the circuit breaker and the load(s) 
being controlled.

To associate a switch leg with a switch leg 
control:

1. From the Navigator in the Equipment screen, select 
the Equipment folder for the space in which the 
panel/switch leg control is located.

The Enclosure dropdown list in the main pane 
displays the existing enclosures for the space.

2. From the Enclosures dropdown list, select the 
panel that contains the switch leg control(s) to be 
associated.

A table showing the panel’s switch leg control 
associations is displayed in the main pane. If there 
are no existing associations, the table is empty.

3. Select the Unassigned Switch Legs panel in the 
Toolbox and then select the Switch Legs folder that 
contains the switch leg to be assigned. Click and 
drag a switch leg directly onto the correct row in the 
table.

The association is made and switch leg settings are 
displayed in the table row.

To remove a switch leg association:
1. Select the switch leg in the table.

2. Click  in  the toolbar, or choose Remove from the 

Edit menu.

NOTE: Clicking  in the toolbar or choosing Delete 
from the Edit menu will delete the entire panel.
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Using the Addressing Screen
The Addressing screen is used to inform the system 
of the location of all addressable hardware in the 
lighting system. Addresses enable a processor to 
communicate with the hardware connected to it.

Opening the Addressing Screen
To open the Addressing screen: Click  in the 
toolbar or choose Addressing from the View Menu.

 From the Addressing screen, you can:
• Add an object to a link on a processor
• Configure the network settings of the processor
•   Create a sensor to Lighting Zone Controller 

association

NOTE: Lighting Zone Controller units are only 
available for North and South America.

Adding an Object to a Link on a 
Processor
A link refers to a low-voltage wire that connects to 
the processor and enables it to communicate with 
other hardware in the lighting system.

To add an object to a link on a processor:
1. From the Navigator in the Addressing screen, select 

the Processor folder for the space in which the 
processor is located.  

The Processor dropdown list in the main pane 
displays the existing processors for the space. The 
Link dropdown list displays available links.

2. From the Processor dropdown list, select the 
processor. From the Links dropdown list, select the 
link on the processor to which the object is to be 
assigned.

Depending on the selected processor and link, the 
appropriate number of address rows are listed in the 
table.

NOTES:
•  AUX and UI links are not addressable from the 

Addressing screen.
•  To rename the processor, select the processor 

from the dropdown list and then enter a new 
name in the Properties box.

3. Select the assignable objects panel in the Toolbox 
and then navigate to the space that contains the 
object to be assigned. Open the appropriate object 
folder and then click and drag the object directly 
onto the correct address row in the table.

The association is made and the properties of the 
object are displayed in the table row.
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To remove an addressed object from the 
processor:

1. Select the object in the table.

2. Click  in the toolbar, or choose Remove from the 
Edit menu.

Configuring the Network Settings of the 
Processor
The eLumenTM software communicates to the 
processor(s) across a TCP/IP network. The network 
settings for each processor are configured using the 
properties window on the Addressing screen.

To configure the network settings of the 
processor:

1. From the Navigator in the Addressing screen, select 
the Processor folder for the space in which the 
object is to be assigned.

2. Select the processor from the Processor dropdown 
list in the main pane.

3. In the Properties box, click each property field to be 
configured and then enter the appropriate network 
setting.

The following table describes the network settings.

NOTE: You cannot change the current address 
fields. Instead, change the future address fields. The 
fields will be updated during the next data transfer 
from the ControlIT application. (For procedures on 
how to transfer data, refer to Chapter 4.)

Setting Description

Unit Address DIP switch address of the pro-

cessor.

IP Address Net work address of the pro-

cessor (factory default is 

192.168.250.1).

Subnet Mask Subnetwork mask (factory default 

is 255.255.255.0).

UI Port User interface port used to com-

municate from the software to 

the processor (factory default is 

8000).
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Creating a Sensor to Lighting Zone 
Controller (LZC) Association
Occupancy sensors and photo sensors can be 
wired to Lighting Zone Controller (LZC) units to 
enhance their functionality in the space. These 
sensors are associated with the unit from the 
Addressing screen.

To associate a sensor with a Lighting Zone 
Controller unit:

1. From the Navigator in the Addressing screen, select 
the Processor folder for the space in which the 
processor is located.

The Processor dropdown list in the main pane 
displays the existing processors for the space. The 
Link dropdown list displays available links.

2. From the Processor dropdown list, select the 
processor. From the Links dropdown list, select the 
LZC link on the processor to which the object is to 
be assigned.

Depending on the selected processor and link, the 
appropriate number of address rows are listed in the 
table.

NOTE: The Sensors field will display only for Lighting 
Zone Controller links. The link type can be changed 
from the link Properties box. 

3. Select the assignable objects panel in the Toolbox 
and then navigate to the space that contains the 
sensor to be assigned. Open the sensor folder and 
then click and drag the object directly onto the 
correct address row in the table.

The association is made and the number of sensors 
associated with the LZC unit is displayed in the 
Sensors field.

To remove a sensor association:
1. From the table in the main pane, click in the Sensors 

field that contains the sensor whose association is to 
be removed.

A browse button is displayed.

2. Click  .

A popup window lists the sensors currently 
associated with that switch leg.

3. Select the sensor to be removed and then click the 
Remove button.
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Using the Group Definition Screen
The Group Definition screen is used to create 
groups and add objects to them. Groups can be 
used to quickly affect a large number of lighting 
system objects simultaneously.
Groups are a programming convenience and are not 
required for a lighting system to operate.

Opening the Group Definition Screen

To open the Group Definition screen: Click  
in the toolbar or choose Group Definition from the 
View Menu.

 From the Group Definition screen, you can:
• Create new groups
• Add objects to groups

Creating a Group
A group is a named collection of one or more 
objects (or one or more groups) that share a 
common functional purpose. Groups can be added 
to a space or to the project.
Example: A group called “public sp aces” could be 
created that contains all public places and their 
control station devices.

To create a new group:
1. From the Navigator in the Group Definition screen, 

select the Groups folder for the space in which the 
processor is located.

The Group dropdown list in the main pane displays 
the existing groups, if any, for the space.

2. Select the Groups panel in the Toolbox. Then click 
and drag the Create New Group option into the 
main pane.

The group is added and you can now assign objects 
to it.

NOTES:
•  To rename the group, refer to “Viewing and Editing 

Object Properties” on page 10.
•  Groups are controlled by applying a mode to them 

from the Mode Definition screen.
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Assigning Objects to a Group
After a group is added to a project or space, you 
assign the objects to be included in it.

To assign objects to a group:
1. From the Navigator in the Group Definition screen, 

select the Groups folder for the project or space.

The Group dropdown list in the main pane displays 
the existing groups for the space.

2. From the Group dropdown list, select the group to 
which you want to assign objects.

3. Select the Assignable Objects panel in the Toolbox 
and then select the folder that contains the object to 
be assigned. Click and drag the object into the 
lower portion of the main pane.

The object is added under the corresponding row 
type in the table.
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Using the Mode Definition Screen
The Mode Definition screen is used to create 
modes (programming functions and values) that 
can be applied to groups and other objects during 
programming.
Modes are a programming convenience and are not 
required for the operation of the lighting system.

Opening the Mode Definition Screen
To open the Mode Definition screen: Click  in 
the toolbar or choose Mode Definition from the 
View Menu.

 From the Mode Definition screen, you can:
• Create new modes
• Add object types to modes

Creating a Mode
A mode is a function and set of associated values 
that determine the behavior of a group or other 
object to which it is applied. Modes are added at 
the project level.
Example: A mode called “Daytime” could be created 
to turn on all lights and disable the control station 
devices in a group that contains spaces and control 
station devices.

To create a new mode:
1. From the Navigator in the Mode Definition screen, 

select the Mode folder for the project.

Existing modes, if any, are displayed in the Mode 
dropdown list in the main pane.

2. Select the Modes panel in the Toolbox. Then click 
and drag the Create New Mode option into the main 
pane.

The mode is added to the project and displayed in 
the Mode dropdown list in the main pane. You can 
now assign objects to the mode.

NOTES:
•  To rename the mode, refer to “Viewing and Editing 

Object Properties” on page 10.
•  To create more than one mode, click and drag the 

Create Multiple New Modes option into the main 
pane. Type the number you wish to add and click 
the OK button.
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Assigning Objects to a Mode
After a mode is added to a project, you assign the 
objects you want it to control.

To assign objects to a mode:
1. From the Navigator in the Mode Definition screen, 

select the Mode folder for the project.

The Modes dropdown list in the main pane displays 
the existing modes for the space.

2. Select the mode from the dropdown list. Select the 
Assignable Object Types panel from the Toolbox 
and then click and drag the type of object to be 
assigned into the main pane.

The object type is assigned to the mode and fields 
for entering object setting values are displayed in the 
table.

To enter setting values for the object assigned to 
the mode:

1. Double-click in the Command field in the row for the 
assigned object.

A dropdown list is displayed.

2. Select the Command value from the dropdown list.

Depending on the value you select, default values 
are displayed in the other fields in the table row.

3. To modify the other settings for the object, click in 
each of the fields and enter a new value. Move from 
left to right across the table row.
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Using the Programming Screen
The Programming screen is used to program control 
station buttons, create programming and schedules, 
and apply schedules to time clocks.

Opening the Programming Screen
To open the Programming screen: Click    in 
the toolbar or choose Programming from the View 
Menu.

 From the Programming screen, you can:
•  Program the buttons for control station devices.
•  Program schedules for time clocks.

Working with Control Station Devices
A control station device is housed in a control 
station and provides a point of input or output. 
In most cases, control stations devices are wall-
mounted controls with buttons.

Control station devices can be programmed to react 
to a button press (Single Action), a button press and 
release (Dual Action), a different action based on the 
status of a part of the building (Conditional), or to run 
a sequence of events (Auto Sequence).

NOTE: For information on programming an 
autosequence, refer to the Online Help in the 
DesignIT application.

Programming a Button for a Single Action
Control station buttons can be programmed to 
execute a single action when pressed (for example, 
pressing the button selects a scene).

To program a button for a single action:
1. From the Navigator in the Programming screen, 

select the space and then the Control Stations 
folder that contains the control station to be 
programmed.

The Control station dropdown list in the main pane 
displays the existing control stations for the space. 
An image of the currently selected control station is 
also displayed.

2. From the dropdown list, select the control station to 
be programmed.

3. From the image of the control station device, click 
the button to be programmed.

The Programming Model dropdown list displays 
available models for the selected button. A model 
specifies how the system responds to user 
interaction.

4. From the Programming Model dropdown list, select 
Single action.
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5. Select the Assignable Objects panel in the Toolbox. 
Navigate to the space that contains the object to be 
controlled by the selected button. Select that object 
folder and then click and drag the object into the 
lower portion of the main pane.

The object is assigned to the button and default 
program settings are displayed in the table.

6. To modify the default settings, double-click the 
Command field. Then select the value you want 
from the dropdown list.

7. To modify other program settings for the object, 
click in each field and enter the new value. Move 
from left to right across the table row.

NOTE: Use the scroll bars to view table fields that 
are hidden from view.
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Programming a Button for a Dual Action
Control station buttons can be programmed to 
execute a single action when pressed (for example, 
pressing the button starts raising the zone intensity) 
and then execute another action when released (for 
example, releasing the button stops raising the zone 
intensity).

To program a button for a dual action:
1. From the Navigator in the Programming screen, 

select the space and then the Control Stations 
folder that contains the control station to be 
programmed.

The Control Station dropdown list in the main pane 
displays the existing control stations for the space. 
An image of the currently selected control station is 
also displayed.

2. From the dropdown list, select the control station to 
be programmed.

3. From the image of the control station device, click 
the button to be programmed.

The Programming Model dropdown list displays 
available models for the selected button. A model 
specifies how the system responds to user 
interaction.  

4. From the Programming Model dropdown list, select 
Dual action.

The Press tab in the main pane is automatically 
selected.

5. Select the Assignable Objects panel in the Toolbox. 
Navigate to the space that contains the object to be 
controlled by the selected button. Select that object 
folder and then click and drag the object into the 
lower portion of the main pane.

The object is assigned to the button and default 
program settings are displayed in the table.

6. To modify the default settings, double-click the 
Command field. Then select the value you want from 
the dropdown list.

7. To modify other program settings for the object, click 
in each field and enter the new value. Move from left 
to right across the table row.

NOTE: Use the scroll bars to view table fields that 
are hidden from view.

8. Select the Release tab in the main pane. Then 
repeat steps 5 through 7 to specify the button 
release action.
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Programming a Button for a 
Conditional Action
Control station buttons can be programmed to 
execute an action based on one or more conditions.
For example, when a button is pressed, you may 
want to select Scene 2 if Scene 1 was previously 
selected. Otherwise, you would like to have the Off 
Scene selected. In this example, you would need to 
create the following program settings:

If 

 The Scene in Space A = Scene 1

Then

 Select Scene 2

Else

 Select Scene Off

End If  
To program a button for a conditional action:

1. From the Navigator in the Programming screen, 
select the space and then the Control Stations 
folder that contains the control station to be 
programmed.

The Control Station dropdown list in the main pane 
displays the control stations for the space. An image 
of the currently selected control station is also 
displayed.

2. From the dropdown list, select the control station to 
be programmed.

3. From the image of the control station, click the 
button to be programmed.

The Programming Model dropdown list displays 
available models for the selected button. A model 
specifies how the system responds to user 
interaction.

4. From the Programming Model dropdown list, select 
Conditional.

A table used to create the conditional programming 
is displayed in the main pane.

At this point, you can create a preset to be used in 
the conditional programming. A preset specifies the 
object(s) that are controlled by the button and the 
action to be performed.
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To create a preset to use for conditional 
programming:

1. Select the Presets tab in the main pane.

2. Click the New button.

3. Select the Assignable Objects panel in the Toolbox. 
Navigate to the space that contains the object to 
be controlled by the conditional button. Select the 
object folder and then click and drag the object into 
the lower portion of the main pane.

The object is assigned to the preset and default 
program settings are displayed in the table.

4. To rename the preset, click in the Name field and 
enter a new name.

If needed, enter a text description of the preset in 
the Description field.

5. To modify the program settings, double-click the 
Command field. Then select the value you want 
from the dropdown list.

6. To modify other program settings for the object, 
click in each field and enter the new value. Move 
from left to right across the table row.

NOTE: Use the scroll bars to view table fields that 
are hidden from view.

7. Repeat the procedure to create all presets needed 
to create the conditional programming.

To apply a preset to the conditional 
programming:

1. Select the Press tab in the main pane. 

2. Click the IF cell in the table. From the Toolbox, drag 
the object that the condition is evaluating into the IF 
cell.

A row for the object is added in the table.

3. Click in the row for the object and specify the 
settings and values to be used.

4. Click in the THEN cell on the grid. Click the Add 
Action button in the main pane.

5. Double-click the cell created below the THEN cell. 
Select the preset you created from the dropdown 
list.

6. If needed, click in the ELSE and/or END IF cells. 
Click the Add Action button and then select the 
appropriate preset for those actions.

To remove existing programming:
1. Navigate to the button.

2. Click on the row you wish to remove.

3. Click the remove button .

NOTES: 

•  Be sure to choose an LED preset for your button in 
the Properties Box.
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Working with Schedules and Time 
Clocks
A schedule is a collection of event/programming 
pairs. A schedule identifies the programmed 
commands to be executed within the lighting system 
at a certain time. You can create weekly schedules 
(for ongoing events that occur weekly) or date-
specific schedules (for holidays or other special 
events).

Schedules are applied to time clocks, which are 
calendars that identify when scheduled events are to 
occur.

It is important to understand the workflow needed to 
set up the schedules and time clocks for a system:

1. Identify the purpose of the schedule (events to be 
included, objects to be affected, and commands to 
be executed).

2. Create the programming to be used in a time clock.

3. Create the schedule and apply a time to the 
programming.

4. Apply the schedule to a time clock within the 
system.

Planning Schedules and Time Clock 
Configurations
Before you create the programming for a schedule, 
it is helpful to map out the schedule on paper. This 
will make it easier to understand how a program, 
schedule, and time clock work together to control 
the lighting system.

For example, suppose you want to turn off Zone 1 
and Zone 2 at 2PM on August 6:

•  The programming portion is zone 1 = 0% and 
zone 2 = 0%.

•  The schedule portion is the real-time event of 2PM.

• The time clock portion is August 6.

Programming and schedules are created at the 
project level. Time clocks can be configured at both 
the project and space level.
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Creating New Programming for a Schedule
Programming is predetermined behavior that 
is defined to occur as the result of an event 
(astronomic or real-time).

To create new programming for a schedule:
1. From the Navigator in the Programming screen, 

select the Programming folder for the project.

The Programming dropdown list in the main pane 
displays existing programming, if any, for the project.

2. Select the Programming panel in the Toolbox. Then 
click and drag the Create New Programming option 
into the top portion of the main pane.

The programming is added. You can now assign 
objects and programming actions to it.

NOTE: To rename the programming, refer to 
“Viewing and Editing Object Properties” on page 10.

To assign objects and actions to the 
programming:

1. If it is not already selected, select the programming 
from the Programming dropdown list.

2. From the Programming Model dropdown list, select 
Single action or Conditional.

3. Select the Assignable Objects panel in the Toolbox. 
Navigate to the space that contains the object to be 
controlled by the programming. Select that object 
folder and then click and drag the object into the 
lower portion of the main pane.

The object is added to the program and default 
program settings are displayed in the table.

4. Modify the program settings, as needed.

For procedures on how to modify single action 
settings, refer to “Programming a Button for a Single 
Action” on page 35.

For procedures on how to modify conditional action 
settings, refer to “Programming a Button for a 
Conditional Action” on page 38.

After the schedule programming is created, you can 
create the schedule.
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Creating a New Schedule
A schedule is a collection of event/programming 
pairs. A schedule identifies the programmed 
commands to be executed within the lighting 
system at a certain time. Schedules are created at 
the project level.

To create a new schedule:
1. From the Navigator in the Programming screen, 

select the Schedules folder for the project.

The Schedule dropdown list in the main pane 
displays the existing schedules, if any, for the 
project.

2. Select the Schedules panel in the Toolbox. Click and 
drag the Create New Schedule option into the main 
pane.

The schedule is added and displayed in the 
Schedule dropdown list. You can now add 
astronomic and/or real-time events to it.

NOTE: To rename the schedule, refer to “Viewing 
and Editing Object Properties” on page 10.

Adding an Astronomic Event to a Schedule
An astronomic event is an event defined to occur 
at a certain time period before or after sunrise or 
sunset.
To add an astronomic event to a schedule:

1. From the Navigator in the Programming screen, 
select the Schedules folder for the project.

The Schedule dropdown list in the main pane 
displays the existing schedules for the project.

2. From the dropdown list, select the schedule to which 
the astronomic event is to be added. Then select the 
Astronomic Events tab in the main pane.

3. Select the Programming panel in the Toolbox. 
Click and drag the predefined programming for the 
schedule into the lower portion of the main pane.

This should be programming you created specifically 
for this schedule. (For procedures, refer to “Creating 
New Programming for a Schedule” on page 41.)

The programming is added to the schedule and 
default event settings are displayed in the table.

4. To modify the setting values, double-click the 
Sunrise/Sunset field. Then select the value you want 
from the dropdown list.

5. Click in the +/- field. Select + to start the event after 
sunrise or sunset. Select - to start the event before 
sunrise or sunset.

6. Click the Time field. Enter the number of hours and 
minutes to wait before starting the event.
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Adding a Real-Time Event to a Schedule
A real-time event is an event defined to occur at a 
specific time of day.

To add a real-time event a schedule:
1. From the Navigator in the Programming screen, 

select the Schedules folder for the project.

The Schedule dropdown list in the main pane 
displays the existing schedules for the project.

2. From the dropdown list, select the schedule to 
which the real-time event is to be added. Select the 
Real-Time Events tab in the main pane.

3. Select the Programming panel in the Toolbox. 
Click and drag the predefined programming for the 
schedule into the lower portion of the main pane.

This should be programming you created specifically 
for this schedule. (For procedures, refer to “Creating 
New Programming for a Schedule” on page 41.)

The programming is added to the schedule and a 
default event time is displayed in the table.

NOTE: To change the event time, double-click in the 
Time field and enter a different time.

Adding a Date-Specific Schedule to a Time Clock
If a schedule is designed for events that occur on 
one or more specific dates (for example, a holiday or 
special time period), it is added to the time clock for 
those dates only. 

NOTE: Default weekly schedules can also be added 
to a time clock. Refer to “Adding a Default Weekly 
Schedule to a Time Clock” on page 44.

To add a date-specific schedule to a time clock:
1. From the Navigator in the Programming screen, 

select the Time Clock folder for the project. Or to 
add a schedule to a space, select the Time Clock 
folder for the space.

A calendar for the time clock is displayed in the main 
pane. Today’s date is automatically selected.

2. Select the date to which you want to add the 
schedule.

NOTE: Use the scroll arrows to scroll through the 
calendar months.

3. Select the Schedules panel in the Toolbox. Click 
and drag the schedule to be assigned into the main 
pane.

The schedule is assigned and the calendar date is 
highlighted in red. 
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4. If the schedule applies to more than one date, select 
the next date and repeat the procedure.

To view the schedule for a date: Click the date in 
the calendar. 

Adding a Default Weekly Schedule to a Time 
Clock
If a schedule is designed for events that occur 
weekly, it is added to the system as a default 
schedule.
NOTE: Default schedules will occur on the same day 
every week. To add a date-specific schedule to a 
time clock, refer to page 43.

To add a default weekly schedule to a time 
clock:

1. From the Navigator in the Programming screen, 
select the Time Clock folder for the project. Or to 
add a default schedule to a space, select the Time 
Clock folder for the space.

The time clock calendar is displayed in the main 
pane. Today’s date is automatically selected.

2. Select the Schedules panel in the Toolbox. Click and 
drag the Add Default Schedule option into the main 
pane.

The Default Schedule Creation window displays. It 
contains a placeholder for each day in the week. It 
also lists the existing schedules for the project or 
space. 

3. From the Default Schedule Creation window, click 
and drag a schedule onto each day that it should 
occur.
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4. When you are finished setting default schedules, 
click the OK button.

Days in the calendar that have been assigned a 
default schedule are highlighted in blue in the main 
pane.

NOTE: To remove a default schedule, please refer to 
the Online Help.

To view the schedule for a date: Click the day in 
the calendar. 

NOTE: Only one schedule can run on each time 
clock for a given day.
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Changing When a Time Clock Event 
Happens
A schedule is a collection of event/programming 
pairs. A schedule identifies the programmed 
commands to be executed within the lighting 
system at a certain time. Schedules are created at 
the project level.

To change the time an event occurs:
1.From the Navigator in the Programming screen, 

select the Schedules folder for the project.

The Schedule dropdown list in the main pane 
displays the existing schedules for the project.

2.Select the tab for Real-Time or Astronomic events.

Real-Time events occur at a specific time, while 
Astronomic events occur relative to sunrise or 
sunset.

3.Using the table in the center of the main pane, enter 
a new time for the event.

To change the day an event occurs:
1.Select the day that the event occurs from the 

calendar at the top of the main pane.  

2.Click on the remove icon from the menu bar.

3.You can now add a date-specific schedule (see 
page 43) or add a default weekly schedule (see 
page 44).

Viewing and Changing What the Time 
Clock Event Does
Programming is predetermined behavior that 
is defined to occur as the result of an event 
(astronomic or real-time).

To locate programming on a specific time clock:
1.From the Report menu, select Time Clock 

Programming.

2.Next, select a date or date range for the report.

3.The report will display the time clock, event name, 
event time, programming name, and schedule name.

 NOTE: For more information on running reports 
in the DesignIT or ControlIT applications, refer to 
Generating Reports on page 64.
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To change existing time clock programming:
 From the Navigator in the Programming screen, 

select the Programming folder for the project.

The Programming dropdown list in the main pane 
displays existing programming for the project.

NOTE: To rename the programming, refer to 
“Viewing and Editing Object Properties” on page 10.

Add commands to the programming:
1.Select the Assignable Objects panel in the Toolbox. 

2.Navigate to the space that contains the object to be 
controlled by the programming. 

3.Select that object folder and then click and drag the 
object into the lower portion of the main pane.

Edit commands to the programming:
1.From the table in the main pane, select the 

command, level, fade time, or delay time.  

2.Add or remove commands as necessary.

Remove commands from the programming:
1.Select the command within the table on the main 

pane.

2.Click on the Remove icon from the menu bar.

Change the programming model from Single 
Action to Conditional:

1.Using the Programming Model dropdown list select 
Conditional.

2.A dialog box will appear asking you to choose to 
modify the existing programming or to create new 
programming.  If you choose to edit the existing 
program, any scheduled events will be affected. 
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Chapter 3

eLumenTM users

(disabled users are dimmed)

SecureITTM

Overview
The SecureITTM appliaction enables an eLumenTM 

administrator to manage eLumenTM Lighting Control 
user accounts.
From the SecureITTM application, an administrator 
can:
• Add and delete users
• Enable and disable users
• Associate users with projects
• Change a user’s password
• Change a user’s basic information
• Set application level access 
• Set application feature privileges
• Set space level access

Starting and Exiting SecureITTM

To start SecureITTM:
1. Double-click the SecureITTM icon  on the 

desktop. Or from the Start menu, choose Lutron 
Electronics>SecureIT. 

You are prompted to login.

2. Enter your user name and password. Then click OK.

The SecureITTM window displays all eLumenTM users.

To exit SecureITTM: Open the File menu and choose 
Exit.
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Adding Users
NOTE: Only available to eLumenTM administrators.

Users must be added to SecureITTM to use the 
eLumenTM software tools.

To add a user:
1. From the SecureITTM application window, open the 

File menu and choose Add>User.  Alternatively, you 
can click on the Add button at the bottom of the 
screen.

The Add a User window displays.

2. Enter the user settings.

3. Click the OK button.

The user is added to the list in the SecureITTM 

window. 

NOTE: The new user that was created must be 
enabled and associated with a project before the 
user will be active (see page 50).

Deleting Users
NOTE: Only available to eLumenTM administrators

To delete a user:
1. From the SecureITTM application window, select the 

user.

2. Open the File menu and choose Delete>User.

3. Click the OK button to confirm the deletion, or click 
the Cancel button to cancel the deletion.

The following table describes the user settings.

Setting Description

User Name 1-30 character user name used 

to login to eLumen software 

tools.

First Name The user’s fi rst name.

Last Name The user’s last name.

User Locale Language to be displayed within 

eLumen software suite for the 

user.

Password 0-30 character password used to 

login to eLumen software tools

Confi rm Password Re-type the password in this 

fi eld to confi rm that it is entered 

correctly.

C
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Projects 
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Enabling and Disabling Users
An administrator must enable users in order for 
them to login to the eLumenTM software tools.
To enable a user: Select the user name. Then, 
open the File menu and choose Enable>User.  
Alternatively, you can click on the Enable User 
button at the bottom of the screen.
To disable a user: Select the user name. Then, 
open the File menu and choose Disable>User.  
Alternatively, you can click on the Disable User 
button at the bottom of the screen.

Associating Users with Projects
An eLumenTM administrator must associate users 
with the projects they can access within the 
eLumenTM software tools.

To associate a project with a user:
1. From the SecureITTM window, open the File menu 

and choose Add>User Project.

The Associate Users with Projects window is 
displayed.

2. From the dropdown list, select the user.

3. From the All Projects box, select the project to be 
associated with this user.

4. Click the  button.

The association is made and the project name is 
displayed in the User’s current projects box.

The next time the user logs in to an eLumenTM 
software tool, the associated project(s) will be 
displayed in the navigation tree.

To remove a project association:
1. From the Associate Users with Projects window, 

select the user from the dropdown list.

2. From the User’s current projects box, select the 
project to be removed from the user.

3. Click the  button.
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Resetting a User’s Password
To reset a user’s password:

1. From the SecureITTM application window, select the 
user. Then click the Set Password button.

The Set Password dialog box displays.

2. Enter the new password in each field. Then click the 
OK button.

Changing a User’s Basic 
Information
To change a user’s basic information:

1. From the SecureITTM application window, select the 
user. Then click the Properties button.

2. Change the properties for the user, as needed. Then 
click the Close button.

Viewing User Privileges
To view a user’s privileges:

1. From the SecureITTM application window, select the 
user.

2. Open the Edit menu and choose Properties.

3. You can now view the applications, features, and 
spaces that the selected user has access to use.

4. Click on the Close button to return to the SecureITTM 
application window.

Modifying User Privileges
Setting Space Level Access
NOTE: Only available to eLumenTM administrators

To set application access for a user:
1. From the SecureITTM application window, select the 

user.

2. Open the Edit menu and choose Properties.

3. Click on the Modify Privileges tab.

Top-level spaces appear at the top of the software 
tree list within the eLumenTM Suite of tools.  A user 
has access to all spaces underneath a top-level 
space.

A top-level space that can be accessed will be 
marked with a check ✓.  A top-level space that 
cannot be accessed will be marked with an ✘. 
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To set access to spaces:
1. Select the top-level space for a particular project 

and click on the Set button.  

2. Repeat this process for all spaces that should be 
visible at the top-level.

NOTES: 
•  Access will be granted to all spaces and 

subspaces that are marked as top-level.
•  It is possible to have more than one top-level 

space. A space can only be a top-level space 
if none of the spaces above it within the same 
branch are also top-level spaces.

To remove access to spaces:
1. Select a top-level space for a particular project and 

click on the Remove button.

2. Repeat this process for all spaces that should not 
be visible to the user.

NOTE: To restore a space to the list of visible 
spaces, select the space and click on the Set 
button.

Setting Application Level Access
NOTE: Only available to eLumenTM administrators.

To set application access for a user:
1. From the SecureITTM application window, select the 

user.

2. Open the Edit menu and choose Properties.

3. Click on the Modify Privileges tab.

4. Deselect check boxes to remove access to those 
programs.

Setting Application Features Access
NOTE: Only available to eLumenTM administrators.

To set application features access for a user:
1. From the SecureITTM application  window, select the 

user.

2. Open the Edit menu and choose Properties.

3. Click on the Modify Privileges tab.

4. Click on the Set Application Features Access button.

5. Use the dropdown box and select an application.

6. Remove the check boxes from the features that you 
wish to have removed from the user’s access rights.
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Chapter 4

Tabs

Subtabs for the 

currently selected tab

Navigation tree Status bar Main pane

NOTES: 

• The ControlITTM application is not intended for 
system modeling or programming. For modeling 
and programming procedures, refer to Chapter 2: 
DesignITTM.

• Actions initated from the ControlITTM application will be 
sent to the system immediately, but the status may not 
be displayed for up to one minute.   

ControlITTM  
Overview
ControlITTM is a web-based interface used to 
monitor and control a facility’s lighting system in 
real-time. The ControlITTM application enables you 
to view the status of the lighting system at any time 
and temporarily change the settings specified in 
DesignITTM.
From the ControlITTM application, you can:
•  View current status and details on spaces 

(including subspaces), zones, control station 
devices, calendar events, and variables

• Select scenes and modes in any space
•  Set zone intensities, including raise/lower, on/off, 

and full on/off
• Enable/disable control station devices
• Enable/disable time clocks
• Set variable states
• Set the state of movable walls
• Apply modes to groups
• Run reports, including time clock and event log
•  Perform maintenance or troubleshooting by 

checking communication channels and software 
error logs

•  Process system settings, including compiling a 
project and transferring it to the processor(s)

When you change real-time settings using the 
ControlITTM application, the system stays in that 
temporary state until a time clock event, button 
press, or other user interaction occurs. Real-time 
changes made in the ControlITTM application do not 
modify the system settings specified in DesignITTM.

Performing Basic ControlITTM 

Operations
The following topics contain procedures used to 
perform basic ControlITTM operations.

Starting and Exiting ControlITTM

To start ControlITTM:
1. Double-click the ControlITTM application icon  on 

the desktop.

You are prompted to login.

2. Enter your user name and password. Then click OK.

The ControlITTM Zones page is displayed. The page 
contains tabs and related subtabs, a navigation tree, 
a main pane, and a status bar.

To logout of ControlITTM: Click Logout.

To exit ControlITTM: Choose Close from the File 
menu or click the ✘ in the upper right-hand corner of 
the screen.

C
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Selecting ControlITTM Tabs and Subtabs
To work within the ControlITTM application, select a 
function tab. 

Related subtabs for that function are displayed.

Click a subtab to select a specific operation.

NOTE: Function tabs can be visable or hidden  
depending on the level of access that has been 
granted to that user by the eLumenTM administrator. 

Using the Navigation Tree
The navigation tree on ControlITTM pages displays 
levels of system information through which you can 
navigate. The project folder is positioned on top, with 
system spaces arranged hierarchically below it.

NOTE: The projects available to you in the navigation 
tree depend on the system privileges associated with 
your user name. For details about user names, refer 
to Chapter 3: SecureITTM.

To open the project folder and display its 
contents: Click the folder’s + sign 

 or simply double-click the folder.

The project folder opens and displays the first level 
of spaces in the project.

Click a space’s + sign to display the next level of 
spaces (subspaces). Continue to open folders until 
you reach the desired level of the selected project.

If a space does not have a + sign, it does not have 
subspaces.

To close a project or space and hide its 
contents: Click its - sign or double-click its name.
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on the page

Showing and Hiding the Details Tab
If the ControlITTM page you are viewing has a Show 
Details Tab button, you can view details about a 
space or other object shown in the table on the main 
pane.

To show the details tab for an object: Select the 
object in the table. 

 
 Then click the Show Details tab button.

The Details tab is shown at the bottom of the page.

To hide the Details tab: Click the Hide Details Tab 
button.
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Monitoring and Controlling the 
System
From the Monitor and Control page in the 
ControlITTM application, you can view a list of all the 
spaces in the system and select a scene and/or 
mode for any space.
You can also view and set the state of:
• Zone intensities
• Programmable devices
• Time clocks
• Variables
• Movable walls
• Groups

NOTE: When you change the real-time state of an 
object using the ControlITTM application, the system 
stays in that temporary state until a time clock event, 
button press, or other user interaction occurs. Real-
time changes made in the ControlITTM application 
do not modify the system settings specified in 
DesignITTM.

To display the Monitor and Control page: Select 
the Monitor & Control tab.

Viewing System Spaces and Selecting 
Scenes and Modes
The Overview and Detailed Overview pages are 
used to view system spaces and select scenes and 
modes.

Viewing and Selecting Space Scenes and Modes 
Using the Overview Page
The Overview page lists all the spaces in the system 
and enables you to apply a different scene or mode 
to any space.

To view all system spaces using the Overview 
page: From the Monitor & Control page, click the 
Overview subtab.

Once the Overview page is displayed, the table in 
the main pane lists all the spaces in the project and 
the last selected scene for each space.
To select a scene for a space: Click in the Last 
Selected Scene field for the space. From the 
dropdown list, select the scene to be applied. Then 
click the Apply button.
To apply a mode to a space: Click in the Select 
Mode field for the space. From the dropdown list, 
select the mode to be applied. Then click the Apply 
button.
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Viewing and Selecting Space Scenes and Modes 
using the Detailed Overview Page      

The Detailed Overview page displays the scene and 
mode for a specific space and enables you to apply 
a different scene or mode. Light level and power 
graphs are also displayed.

To view a specific space using the Detailed 
Overview page:

1. From the navigation tree in the Monitor & Control 
page, select the space you want to monitor.

2. Click the Detailed Overview subtab.

The Detailed Overview page displays detailed 
information about the space.

NOTE: The power graph is displayed only for spaces 
that contain Lighting Zone Controller (LZC) units.
LZC units are only available for North and South 
America.

To select a scene for the space: From the Last 
Scene Selected dropdown list, select the scene to 
be applied. Then click the Apply button.
To apply a mode to the space: From the Apply 
Mode dropdown list, select the mode. Then click the 
Apply button.

If the selected space contains LZC units, the 
Detailed Overview page contains additional 
information.

To change the timeframe of the data displayed 
in the power and light level graphs: Select a time 
interval from the dropdown list.

Viewing and Setting Zone Intensities
A zone is a collection of switch legs controlled 
simultaneously as one unit (also called a channel by 
some lighting designers).

To view the intensity setting for a zone:
1. From the navigation tree on the Monitor and Control 

page, select the space that contains the zone 
whose intensity you want to view.

2. Click the Zones subtab.

The zones for that space and their current intensities 
(lighting levels) are displayed in the table.

To set the intensity of a zone:
1.Select the zone in the table.

2.Click  to lower or raise the intensity.

• To turn the zone ON or OFF, click the Turn On or 
Turn Off button.

• To turn all zones for the space ON or OFF, click the 
Full On or All Off button. This turns ON or OFF all 
zones in that space and any subspaces.
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To modify settings of a zone:
• To view details about a zone, select the zone in the 
table. Then click the Show Details Tab button.

   The zone Details tab is displayed and you can view 
or apply additional zone settings.

• To apply a mode to the zone, select the mode 
from the Select Mode dropdown list. Then click the 
Apply button.

• To lower or raise the zone intensity, use the slider 
or click  or enter a value in the Set Level field 
and then click the Apply button.

• To start or stop zone flashing, click the Start Flash 
or Stop Flash button. 

To modify additonal settings of a Lighting Zone 
Controller (LZC) Unit:

• To set the load shed, enter a value in the Load 
Shed % field and then click the Apply button.

• To view the power and light levels for the zone, 
select the Graphs subtab. Use the dropdown list to 
select the time interval to be displayed.

• To view and adjust the settings for when a LZC unit 
goes into Afterhours mode, select the Afterhours 
subtab. This mode is used to turn the lights OFF 
after a set time in which the space is unoccupied.

• To view and adjust the settings for sensors 
attached to a LZC unit, select the Sensors subtab.

• To view and adjust the LZC unit settings, select the 
Settings subtab.

  The following table describes the LZC unit settings.

Setting Description

High-end Trim Maximum actual light level that is 

allowed to be set (for example, 

Actual=90 when user sets it to 100)

Low-end Trim Lowest the light level can go before 

the OFF command is sent.

Emergency Level Light level the unit will go to during 

Emergency mode.

Status Indicates if a wall control is 

connected.

Wall Control State Indicates if the wall control is 

enabled or disabled.
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Control station Control station device

Viewing and Setting the State of 
Programmable Devices
Programmable devices include wall controls, AV 
equipment, and RS232 equipment.
To vie w the state of a programmable device:

1. From the navigation tree on the Monitor and 
Control page, select the space that contains the 
programmable device.

2. Select the Programmable Devices subtab.

The programmable devices for the space are listed 
in the table.

NOTE: If there are subspaces below the selected 
space, the subspaces are also listed in the table. 
Click the Go to button for a subspace to view its 
programmable devices.

To enable or disable a programmable device: 
Check or uncheck its Enable checkbox.

To enable or disable all programmable devices in 
the space and its subspaces: Click the Enable All 
or Disable All button.
To view more details about a programmable 
device: Select the device in the table. Then click the 
Show Details Tab button.

The Details tab is displayed and you can view or 
apply additional device settings.

To virtually “press” a button on the device: Click 
the button in the image. 
NOTE: Since a release event cannot be simulated in 
the ControlITTM application, pressing the button may 
not have the same effect as a real button press on 
the actual device. 

To apply a mode to the device: Select the mode 
from the Select Mode dropdown list. Then click the 
Apply button.
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Time clock Schedule

Viewing and Setting the State of Time 
Clocks
A time clock is a collection of schedules. Time 
clocks are used to trigger lighting system events.

To view the state of a time clock:
1. From the navigation tree on the Monitor and Control 

page, select the space that contains the time clock. 
Or to view the time clock for the project, select the 
project.

2. Select the Time Clocks subtab.

The time clock is listed in the table in the main pane.

NOTE: If there are subspaces below the selected 
space, the subspaces are also listed in the table. 
Click the Go to button for a subspace to view its 
time clock.

To enable or disable the time clock: Select the 
state from the dropdown list.

To view the time clock schedules: Select the time 
clock’s + sign.

To enable or disable all time clocks in the 
selected space and its subspaces: Click the 
Enable All or Disable All button.

To re-enable all time clocks at midnight, check the 
Re-enable at Midnight checkbox.

To view details about a time clock schedule: 
Select the schedule in the table. Then click the 
Show Details Tab button.

The Details tab is displayed and you can view 
schedule events.

To apply a mode to the schedule: Select the 
mode from the Select Mode dropdown list. Then 
click the Apply button.



eLumenTM Software User Guide    61

Viewing and Setting the State of 
Variables
A variable is a programming object that is referenced 
by other objects for programming purposes. A 
variable can be one of three types: True/False, Multi-
state, or Integer.

To view the state of a variable:
1. From the navigation tree on the Monitor and Control 

page, select the project.

2. Select the Variables subtab.

The variables for the project are listed in the table.

To set the variable state: Select the state from the 
dropdown list.
To view details about a variable: Select the 
variable in the table, and then click the Show Details 
Tab button.

The variable Details tab is displayed.

To apply a mode to the variable: Select the mode 
from the Select Mode dropdown list. Then click the 
Apply button.

Viewing and Setting the State of 
Movable Walls
Movable walls can be opened or closed to create 
partitions (subspaces) within a space.

To view the state of a movable wall:
1. From the navigation tree on the Monitor and Control 

page, select the partitioned space that contains the 
wall.

2. Select the Walls subtab.

The movable walls for the space are listed in the 
table.

NOTE: If there are subspaces below the selected 
space, the subspaces are also listed in the table. 
Click the Go to button for a subspace to view its 
movable walls.

To open or close the wall: Select that option from 
the Wall State dropdown list.
To view details about a wall: Select the wall in the 
table, and then click the Show Details Tab button.

The wall Details tab is displayed.

To apply a mode to the wall: Select the mode 
from the Select Mode dropdown list. Then click the 
Apply button.
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Viewing and Setting the State of Groups
A group is a named collection of one or more 
objects (or one or more groups) that share a 
common functional purpose.

To view the state of a group:
1. From the navigation tree on the Monitor and Control 

page, select the project or space that contains the 
group.

2. Click the Groups subtab.

The groups in the space are listed in the table.

NOTE: If there are subspaces below the selected 
space, the subspaces are also listed in the table. 
Click the Go to button for a subspace to view its 
groups.

To apply a mode to a group: Select the mode 
from the Select Mode dropdown list. Then click the 
Apply button.
To view details about a group: Select the group 
in the table, and then click the Show Details Tab 
button.

The group Details tab is displayed. Members of the 
group are listed in the table.

To run the scene capture macro:
Your system may be equipped with certain hardware 
devices that can modify the values of scenes. These 
devices are called hand-held programmers and 
ViseoTM control station devices. When scene 
changes are made from the devices, the changes 
are stored in the processors only. If you transfer to 
your system without saving these changes to the 
database, the changes will be lost. If you choose to 
save the changes, you will do so by clicking on the 
macro option under Monitor & Control. Choose the 
scene capture macro and press the run button. The 
macro may take several minutes to execute. The 
screen will update to inform you that the operation 
was completed successfully.
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System Settings
From the System Settings page, you can:
•  Compile the project database and then transfer it 

to the lighting system hardware
• View and set preferences
To display the System Settings page: Select the 
Systems Settings tab.

NOTE: Function tabs can be visable or hidden  
depending on the level of access that has been 
granted to that user by the eLumenTM administrator.

Compiling and Transferring Project Data
Please refer to Chapter 7: Compile and Transfer.

Viewing and Setting Preferences
Preference settings specify the items to be recorded 
about the system (for example, when graphs are 
displayed and reports are generated.)

To enable/disable DataLogging: 
1.From the System Settings page, select the 

Preferences subtab.

2.Check or uncheck the setting checkboxes. Then 
click the Save button.
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Generating Reports
The ControlITTM application enables you to generate 
a variety of reports. Reports are helpful for 
monitoring system usage and performance.

To generate a report:
1. Select the Reports tab.

The Reports page is displayed.

2. From the Select a Report dropdown list, select the 
type of report to be generated.

Depending on the report type you select, related 
report parameters are displayed in the Report 
Parameters box.

3. Select the parameters to be included in the report.

4. Click the Run Report button.

The report is generated and displayed in PDF 
format. Use the Adobe window controls to save or 
print the report.

NOTE: Some reports will not contain data until 
relevant preferences are set. See “Viewing and 
Setting Preferences” on page 63.
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Performing Maintenance
From time to time, you may need to perform system 
maintenance or troubleshoot problems by checking 
communication channels, switch legs, and software 
error logs. You can also display lamp information for 
Lighting Zone Controller units.
System maintenance is performed from the 
Maintenance page.

To display the Maintenance page: Select the 
Maintenance tab.

Running Diagnostic Tests
To run a diagnostic test:

1. From the Maintenance page, select the Diagnostics 
subtab.

2. From the Select Test/Report dropdown list, select 
the test to be run.

3. Select the parameters to be included in the test.

4. Click the Start button.

Displaying Lamp Information for Lighting 
Zone Controller Units
To display lamp information for Lighting Zone 
Controller units: From the Maintenance page, select 
the Lamp Information subtab.
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Chapter 5

Navigator

ConfigureITTM

                                                  
Overview
The ConfigureITTM application enables you to make 
real-time configuration changes to your scenes. 
From Configure ITTM, you can:
•  Modify scene values and save changes to the 

hardware and/or the database
• Modify zone intensity
• Modify zone fade time
• Modify zone delay time
•  View scene values from the processor or the 

database

NOTE: The ConfigureITTM application is designed to 
only work with panel-based zones or LZC units.

Starting and Exiting ConfigureITTM

To start ConfigureITTM:
1. Double-click the ConfigureITTM application icon  

on the desktop. Or from the Start menu, choose 
Lutron Electronics>ConfigureITTM.

You are prompted to login.

2. Enter your user name and password. Then click OK.

The ConfigureITTM application window displays the 
list of spaces and scenes in the navigator.

To exit ConfigureITTM: Choose Exit from the File 
menu.
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Click here to make 

the selected scene 

active in the space

Viewing or Modifying Scene Values 
in a Space
A scene is a lighting effect achieved by adjusting 
one or more zones to preset levels. While scenes 
are programmed in DesignITTM, from the 
ConfigureITTM window, you can:
• View scene lighting levels for each zone in a space
• Make a scene active in a space
• Adjust the scene values for one or more zones

To select a scene and view its values:
1. From the navigation tree in the ConfigureITTM 

window, select the space that contains the scene 
you want to view or modify.

2. Within that space, select the Scenes folder and then 
a specific scene.

3. Select Mode “Online” to modify scene values and 
lighting levels in real-time or select “Offline” to only 
change the scene values.

4. Select Value Source from where you would like to 
read the scene values. You can view values that 
were stored in the “Processor” or were saved in the 
“Database”.

The Scene Capture tab displays the programmed 
scene lighting levels for each zone in the space.

To make the selected scene active in the space: 
Click the Select ‘[scene name]’ button.

NOTES: 

•This function is not available in offline mode.
• If the Use Fade and Delay checkbox is checked, 
selecting the scene will apply it to the zones using 
the programmed fade and delay values. Otherwise, 
the scene will be applied instantly in the space.
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Set the fade and delay times by 

typing in the number of seconds 

in the appropriate field

Selected 

zones are 

highlighted

Use sliders or the 

zone level field to set 

the intensity
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To adjust the zone values in a scene:
1. In the Make Scene Adjustments portion of the 

window, select the zone to be modified.

The zone is highlighted to show that it is selected.

NOTE: SHIFT-click and/or CTRL-click to select 
multiple zones. Press CTRL-A to select all zones in 
the space.

2. To adjust the programmed lighting level for the zone, 
use the slider control or enter the intensity value in 
the Level field.

3. If needed, enter the number of seconds in the Fade 
and Delay fields.

To save the modified scene values:
1. Select the Save to Processor only option. The 

adjustments will be saved to the processor, but not 
permanently saved in the database.

 or

 Select the Save to Processor and Database option. 
The adjustments will be saved to the processor and 
also permanently saved in the database.

2. Click the Save button.

NOTES: 

• Scene changes saved only to the processor will 
be overwritten the next time a database transfer is 
done.

• For more information on transferring data to the 
processor, refer to Chapter 4: ControlITTM.



Chapter 6
Backup, Restore, and 
Update Tool

Overview
The Backup, Restore, and Update tool (BRU tool) 
is a utility that enables you to manage the MS SQL 
database.  With the BRU tool you can:
• Backup an existing database
• Restore a database from an external file
• Update a database to the latest software version

NOTE: The BRU tool is not intended to create a 
database. For information on creating a database, 
refer to Chapter 2: DesignITTM.

Performing Basic BRU Operations
The following topics contain procedures used to 
perform basic BRU operations.

Starting and Exiting the BRU Tool
To start the BRU tool:

1.The default location of the BRU tool application in 
the file system is “\Lutron\DB Backup 
Restore\Lutron_Monitor_DBBackupRestore.exe”.     

You are prompted to login.

2.Once the application is started, you will need to 
login with the username database and the password 
restore. Then click OK.

Database Backup
To backup the database to an external file:

1.Select the Backup tab on the form. 

The “LDAC” database is already selected for you on 
the “Select Database” drop down list. 

2.Click the Browse button to specify a backup file, or, 
type backup file name and path in the “Backup” to 
text box. 

3.Click the Backup button to backup the database. 

4.When the “Database Backup Completed” message 
box pops up, the database has been successfully 
backed up to the file you specified.
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Database Restore 
To restore the database from an external file:

1.Select the Restore tab on the form. 

The “LDAC” Database is already selected for you on 
the “Select Database” drop down list.

2.Click the Browse button to select a backup file or 
type the full path and name of a backup file in the 
Restore from text box.

3.Click the Restore button to restore the database. 

4.When the “Database Restore Completed” message 
box pops up, the database has been successfully 
restored.

NOTE: You cannot restore a database if there are 
active connections to the database. To close these 
connections, you will need to stop the 
“Lutron_LDAC_ControlSystem” and 
“Lutron_LDAC_RuntimeLogic” services. 

For more information, please see Chapter 8: System 
Services.

Database Update 
To update the database to the current version:

1.Select the Update tab on the form. 

The server name, database name, and database 
version will be displayed on the form. 

2.If at least one database version is older than the tool 
version and no database version is newer than the 
tool version, the Update button will be enabled and 
you can use the tool to update your databases.  

3.Click the Update button to update the databases. 
(The target database version number will be 
displayed on the button.)  

The tool will automatically back up the databases 
before updating them. 

If there is any error during the updating, the tool will 
stop the update process and restore the databases 
to their original state prior to continuing. 

4.When the “Outcome:” field shows “Success”, the 
databases have been successfully updated. 

5.After a successful update, you can click on the 
Undo button to undo the upgrade and revert the 
databases to their previous state.

NOTE: This function can only be used to update 
the Session and LDAC databases after a software 
update has been performed. This process can take 
several minutes to an hour, depending upon the size 
of the database.
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Chapter 7
Compile and Transfer

Overview
The Compiler is a subsystem of the eLumenTM Suite 
that converts the database into the individual files 
that will be transferred into the G7000 processor.  
When you are finished creating or modifying a 
project, you must compile the project before 
transferring the database to the lighting system 
hardware.The output files of each compile are stored 
locally on the database host computer. 

NOTES: 
• The system can be compiled from either the 
DesignITTM or ControlITTM application, but the 
system can only be transferred from ControlITTM. 

• Scene changes will be lost if not saved to the 
database (refer to “Run the Scene Capture Macro” 
on page 62).

Compiling a Project
To compile from DesignITTM:

1.Click on “Tools” and then click on “Compile.”    

2.Next, click on the name of the Project that you wish 
to compile and click the Start Compile button.

3.A popup window will appear asking if you wish to 
lock the database. Locking the database will lock 
the location of objects (spaces, zones, etc.) in the 
database.  Make your selection and then click on 
“OK.”

4.Finally, click on the Compile Details tab to see if the 
compile has completed and if there are any 
warnings or errors.
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To compile from ControlITTM:

1.Click on the System Settings Tab. 

2.Click on the Project Name and then click on “Start 
Compile.”

3.A popup window will appear asking if you wish to 
lock the database. Locking the database will lock 
the location of objects (spaces, zones, etc.) in the 
database.  Make your selection and then click on 
“OK.”

NOTE: Selecting the Lock the Address Reference 
option will lock all space and zone identifiers. This is 
needed only for BMS, RS232, and DMX integration 
jobs.

4.Click on the Show Details tab to see if the compile 
has completed and if there are any warnings or 
errors. When compiling is complete, you can 
transfer the data to the system hardware.

NOTE: Resolve all compile warnings and errors 
before transferring. Click on the Warning/Error tab to 
view this information.
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System Transfer 
The system transfer function of ControlITTM allows 
the user to transfer the compiled database files to 
the processor.

Transferring from ControlITTM

To transfer the database from ControlITTM:
1.Click on the System Settings Tab.

2.Select the Project name that you would like to 
access. If you would like to transfer to a specific 
processor to group of processors, you would need 
to click on the + sign next to the Project name. If 
you would like to transfer to all processors in the 
project, you would simply keep the Project name 
selected.

NOTE: Transferring to individual processors after 
you have made significant changes may cause 
Timeclocks and other Inter-Processor functionality to 
behave incorrectly. Improper scripts or events could 
be run and as such individual processor transfers 
should only be conducted if you are aware of the 
system configuration.

 3. Click on the “Start Transfer” button to begin 
transferring to the project or processor(s) that you 
have selected.
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4.Choose to transfer the System Data, or System Data 
and Power Panel Data. You only need to transfer 
Power Panel Data if you need to transfer information 
to the Circuit Selectors in the field.

5.Click on the “Show Details Tab” button to see the 
progress of the transfer.

6.When the transfer has completed, the transferred 
date field will be populated.
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Transfer Troubleshooting
If you have an error transferring, the following error 
will appear. Please note that this error will also 
appear the first time that you try to transfer after you 
have changed any of the network settings within the 
DesignITTM application.

To fix this error, complete the following steps:
1.Ensure that the UI Link is connected properly.

2.Ensure that the Ethernet cable is connected from the 
computer to the Comtrol Box or to the Processor’s 
Ethernet port.

3.Verify the proper network configuration settings 
are in DesignITTM under the Address Screen. The 
IP Address, Subnet Mask, and UI Port must all 
be set.  The default settings are 192.168.250.1, 
255.255.255.0, and 8000, respectively.

4.Verify communication with the processor by pinging 
the processor’s IP address.  

To ping a processor:
•Open Start menu in Windows toolbar.
•Select Run.
•Type in CMD and press return/enter button.
• In the command window, enter the ping command. 
For example, “ping 192.168.250.1”.

If there is an error communicating with the 
processor, please contact Lutron Technical Support.

5.Ensure that all IP Addresses are unique on the 
network.

6.Ensure that the Runtime and Control services are 
started.



76    eLumenTM Software User Guide

Chapter 8
System Services

Overview
The eLumenTM Software Suite utilizes services that 
run at the system level. This means that these 
services are running in the background while the 
client tools are being used at the user level. The real 
benefit to service-level applications is that a user 
does not need to be logged in for the application to 
be active. The eLumenTM System Services contains 
four components. They consist of the following:

 •  Environment – Provides the configuration settings 
for the eLumenTM software.

 •  Control System – Responsible for all 
communication and message parsing between the 
hardware and the software.

 •   RunTime Logic – Translates low-level commands 
to plain text.

 •  DataLogging – Records user commands and 
historical system settings.

 NOTE: DataLogging is initially disabled. To 
enable datalogging, refer to “Viewing and Setting 
Preferences” on page 63.

Control System 
The Control System is a Windows service and is 
responsible for taking messages from the Runtime 
Logic System, creating hardware commands, and 
sending the commands to the appropriate piece of 
hardware.

The Control System is responsible for the following 
features:

 •   Building messages that hardware can understand 
from a common low-level language. This allows 
the GRAFIK 7000 to easily interface with many 
different types of hardware using various protocols.

 •   Scheduling and Dispatching of commands based 
on priority and scheduling class.

 •   Maintaining simultaneous communication with all 
processors.  

 •   Polling the processors for information to fill 
monitors with data.

 •    Ethernet communications.

Starting the Control System 
The Control System is a Windows Service. This 
means that it starts when the Operating System is 
loaded. A user does not need to log into Windows 
for it to start. To view the status of the Control 
System, you will need to look at the Services 
Console. 
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To view the status of the Control System 
services:

1.Click on Start > Program Files > Administrative 
Tools, and then click on Services.

This will bring up the Services Console. You will 
need to scroll down until you see 
“Lutron_LDAC_ControlSystem.”  When a service is 
running it will show as “Started” within the status 
column.  

To start or stop a service:
1.If it has not been started, simply click on the name 

of the service and then click on start button .  

2.To stop a service, simply click on the stop button   .

NOTE: The only time a service should be stopped is 
if you are restoring a database. The ControlSystem 
and RuntimeLogic services must be running to 
communicate with the hardware.
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Runtime Logic System
The Runtime Logic System is a Windows service that 
is responsible for translating low-level commands 
to something that the user can understand. This 
interface primarily holds data values and interprets 
user requests into a messaging scheme that lower-
level components can understand.  

Runtime Logic is responsible for the following 
features:

 •  Database connectivity for ControlITTM.
 •  Exposing a web service to allow ControlITTM clients 

to connect through HTML pages.
 •  Accepting messages from the messaging server 

for processing.
 •  Providing data to the compiler in formatting low-

level hardware commands.
 •  Storing data that has been collected from 

hardware.
 •  Broadcasting changes in requested data to clients
 •  Creation of controls for quick access.
 •  Decoding and Encoding of messages from the 

hardware.
 •  Normalizing values from hardware to something 

that the user can understand.
 •  Transferring databases to GRAFIK 7000 

processors.

Starting the Runtime Logic System
The Runtime Logic System is a Windows Service.  
This means that it starts when the Operating 
System is loaded. A user does not need to log into 
Windows for it to start. To view the status of the 
Control System, you will need to look at the Services 
Console. 

NOTE: For more information on viewing the status of 
a service, refer to page 77.

For more information on starting or stopping a 
service, refer to page 77.

Troubleshooting the Control and 
Runtime System
When using the Runtime and Control Systems, the 
following is important to keep in mind:

The Control System service must start before the 
Runtime Logic System. Since the Control System is 
not dependent on any other components and has a 
short startup sequence, this is always the case when 
the system starts automatically. If you restart the 
Control System, you will also need to restart Runtime 
Logic afterwards.

The Control System uses an addressing scheme 
to communicate with each piece of hardware. If 
you have not properly set up the addressing and 
connectivity using DesignITTM, you will not be able to 
communicate with hardware.

Runtime and Control System are configured using 
the Environment Utility. Changing the environment 
settings will allow you to customize how the systems 
operate without the need to change software code.  
If you make an environment change, you will need to 
restart each of the services.  

If the services fail to start, it is usually attributed to 
settings in the Environment.

The Runtime Logic System is also dependent 
on the Data Server to start. The Data Server is a 
combination of MS SQL (the database) and Internet 
Information Services (IIS web server). 
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Notes
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Lexicon
Address: A unique alphanumeric identifier that is applied 

to each component in a system communication link.

Addressing Screen: A screen in DesignITTM that allows 
the user to assign control station devices to processors 
and assign addresses to all equipment and control 
station devices.

Assignable Object: An object whose value can be 
modified via an event. Examples would include a 
particular zone or a particular control station device.

Assignable Object Type: A classification of an 
assignable object. Examples of Assignable Objects 
Types include, but are not limited to: zones, walls, 
variables, time clocks, and control station devices.

Astronomic Event: An event defined as a number of 
hours and minutes before or after sunrise or sunset 
time.

Autosequence: A programming model that will 
automatically loop though a series of presets, with 
a user defined dwell time between presets, until it is 
terminated.

Base Model Number: The portion of the model number 
that is required to identify the functionality of the 
device.

Button-by-button programming: A programming 
technique where each button on a control station 
device is programmed individually. This programming 
technique does not limit the user to those objects 
contained by the same space in which the control 
station device is located.

Button Mode: A means by which the programming to 
be executed changes based on the value of a variable 
or moveable wall.

Calendar: Identifies the dates to which a particular 
schedule refers. 

Circuit: A connection between the circuit breaker 
and one or more switch leg controls. (This is not a 
connection between a group of loads and a switch leg 
control. In the 7000 Lexicon, this is referred to as a 
switch leg.)

Client: A software application that provides an interface 
to server-based components.

Client-Server: A network system that utilizes one or 
more servers and one or more clients.

Compile: The act of translating user-defined project data 
into the machine level language that Lutron hardware 
understands.

Conditional: A programming model that may execute 
different presets based on logical statements that 
utilize the values of variables or moveable walls.

Control: An object that allows the user of ControlITTM to 
change the present value of a parameter for an object 
or collection of objects. This will generate an event in 
the system. 

Control Station: One or more ganged control station 
devices under a common faceplate.

Control Station Device: A device that provides a 
point of input or output. In most cases, these are 
wall-mounted controls with buttons.

Control Type: The manner in which a given load 
type can be controlled. Not all control types 
are valid for all load types. Examples of control 
types include, but are not limited to: dimmed and 
switched.

ControlITTM: A user-interface that allows the user 
to monitor and control the system via a standard, 
non-graphical, Web-based control.

Default Schedule: A collection of event/
programming pairs that has been added to a 
Time Clock on a particular day of the week. Once 
added, it will always run on that day of the week.

Delay: A user defined time interval between an 
event and a response (for example, the time 
between the button press and the light turning 
on).

DesignITTM: A user-interface used to create 
a database model of a lighting system and 
implement the desired control strategies.

Dual Action: A programming model that will 
execute a preset while the control is pressed and 
held and then execute a second preset once 
released.

Dwell Time: A user-defined period of time between 
successive presets in an automatic sequence.

Enclosure: The housing in which the equipment is 
installed.

Engraving: User-defined numbers or letters that 
are inscribed on control stations, control station 
devices, or control station device buttons.

Equipment: The hardware of the system that is 
installed in an enclosure or is found in a panel. 
Examples include processors, interfaces, and 
switch leg controls.

Equipment Definition Screen: A screen in 
DesignITTM that allows the user to define the 
equipment for a project. Additionally, switch 
legs are assigned to switch leg controls on this 
screen. 

Event: An occurrence that can trigger programming 
to be executed.

Exception Schedule: A collection of event/
programming pairs that has been added to a 
Time Clock on a particular date or dates.  

Faceplate: A separate, decorative component that 
covers a control station. Also referred to as a 
wallplate or frontplate.

Fade: A change in intensity (bright to dim) of a light 
or lighting environment.

Fade Rate: The rate at which a particular zone 
changes intensity.
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Fade Time: The total time it takes a dimmable zone to 
change intensity from one level to another.

Fixture: A complete electrical device that may consist of 
lamps, relays, motors, ballasts, or receptacles.

Fixture Power Feeds: Refers to one or more electrical 
connections as required by a fixture. Multiple fixture 
power feeds are required for those fixtures that have 
a total current draw that is larger than the capacity 
of one switch leg control and those fixtures that have 
differing load types.

Fixture Type: A reusable template that defines or 
specifies the characteristics of one or more loads that 
are contained within the same housing or apparatus.

Group: A named collection of one or more objects or 
other groups that share a common functional purpose. 
This is consistent with the building automation industry 
standard term.

Group Definition Screen: A screen in DesignITTM that 
allows the user to create new groups or to modify 
existing groups.

Hold: The period of time between a press and release.

Infared (IR) Sensor: A device that controls the lighting 
system by detecting infrared (IR) signals from a 
handheld remote.

LED Logic: Defines the condition for which an LED will 
light.

Link: The means by which the individual parts of a 
lighting control system communicate with each other. 

Load: A device to which power is delivered via a switch 
leg.

Load Schedule: A list of switch leg to switch leg control 
assignments and the switch leg properties, including 
load type, voltage, etc. Typically, this list is delivered on 
a panel-by-panel basis.

Load Shed: The term load shed, in the broadest sense, 
means reducing power consumption by “shedding” 
or reducing some of the load. In a modern building 
this load is primarily electrical, and is due to the 
many computers, lights, HVAC components, coffee 
machines, microwave ovens, etc., operating in the 
building at any given time.  

Load Type: A classification of a load determined by 
the load’s electrical characteristics. The load type 
determines the manner in which the load can be 
controlled based on the switch leg control’s capability.

Logical Definition Screen: A screen in DesignITTM 
that allows the user to create scenes, time clocks, 
variables, and zones.

Macro: Programming that executes on the server.

Mode: A function and a set of associated values that 
determine the behavior of a group or other object to 
which it is applied. This is consistent with the building 
automation industry standard term.

Mode Definition Screen: A screen in DesignITTM 
that allows the user to create new modes or 
modify existing modes.

Model Number: A unique alphanumeric string 
assigned to a Lutron component. 

Object: A generic term that refers to any Lutron 
product or abstract entity that is added to the 
project (for example, Lutron product–GP48; 
abstract entity–scene).

Occupancy Sensor: A device that controls the 
lighting system by detecting whether the space is 
occupied or unoccupied.

Panel: A factory built pre-wired assembly of 
hardware.

Parameter: A property whose value determines the 
characteristics or behavior of an object.

Partitioned/Partitionable Space: A term that 
refers to a specific type of space. A partitionable 
space allows the user to include fixed and 
moveable walls. These walls can be used later 
in the Programming Screen to achieve various 
lighting effects. A partitionable space contains 
child spaces as defined by the Partitionable 
Space Designer.

Partitionable Space Designer: A feature that leads 
the user through all the steps required to define a 
partitionable space.

Photo Sensor: A device that controls the lighting 
system by the current light level in the space.

Preset: A user-defined set of one or more objects 
and their associated commands/levels.

Press: A type of button event. In the case of a 
mechanical button, this occurs when the button 
is depressed.

Processor: A factory-built assembly that contains 
the system information and executes time clock 
events. Each processor contains a unique 
address and all equipment is wired to and 
communicates with a processor.  

Programming: Predetermined behavior that 
is defined to occur as the result of an event. 
Programming does not include the event itself.

Programming Model: Specifies how the system 
responds to user interaction (for example, single 
action, automatic sequence).

Programming Screen: A screen in DesignITTM 
used to program control station buttons, 
create programming and schedules, and apply 
schedules to time clocks.

Project: A named container that includes all 
information about the system.

Project Hardware Type: The lighting control 
product family or families that the user is planning 
to use in a project (for example, HWI, G6000, 
LZC, etc).

Lexico
n
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Real-Time Event: An event defined in terms of the time 
of day.

Release: A type of button event. In the case of a 
mechanical button, this occurs when the button is no 
longer depressed.

Scene: A lighting effect achieved by adjusting one or 
more zones to various levels.

Schedule: A collection of event/programming pairs.

Script: A reusable set of one or more commands that 
resides and is executed in the processor.

SecureITTM: A user-interface that allows an administrator 
to define user accessibility to various aspects of the 
system.

Sensor: A device that controls the lighting system by 
detecting infrared (IR) signals, the current light level in 
the space, or whether the space is occupied.

Sequence: A series of presets that occur successively to 
achieve a desired lighting effect. 

Server: A computer in a network that is used to provide 
services to clients in the network.

Single Action: A programming model that executes the 
same preset for each event.

Space: A generic term that refers to a physical 
representation of a building, or any of its parts. Spaces 
can contain other spaces. Additionally, each space can 
contain other objects. Each object in a space can only 
be assigned to one space.

Switch Leg: A connection between a group of loads and 
a switch leg control.

Switch Leg Control: Any electronic device that controls 
a switch leg by varying the signal delivered to the 
load(s). In most cases, it is situated between the circuit 
breaker and the load(s) being controlled. This includes 
wall box and panel-based switch leg controls.

System: The interconnected components that are 
referenced in an eLumenTM project.

System Definition Screen: A screen in DesignITTM that 
allows the user to create spaces, add control stations, 
add control station devices, and add switch legs.

Time Clock: A collection of schedules.

Transfer: The act of transmitting the compiled data from 
the user-interface to Lutron Hardware or vice-versa. 
This cannot be done in the absence of hardware.

Variable: A user created object that can be of three 
types: True/False, Multi-state, or Integer. Variables can 
be used in the Programming Screen.

Variable State: One of the 255 available values 
of a variable, which is used for conditional logic 
programming. 

Wall: A structure that is used to define a partitionable 
space.

Wall State: A state of a moveable wall (for 
example, fully open, fully closed, half open).

Zone: A group of switch legs controlled 
simultaneously as one unit (also called a channel 
by some lighting designers).
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A
adding users, 49

Addressing screen, 28

Afterhours mode, 58

associating users with projects, 50

astronomic events, 42

AV equipment, 59

B
Backup, Restore, and Update Tool

 basic operations, 69

 database backup, 69

 database restore, 70

 database update, 70

 overview, 69

 starting and exiting, 69

basic operations

 ControlIT, 53

 DesignIT, 7

buttons, programming

 conditional action, 38

 dual action, 37

 removing existing, 39

 single action, 35

C
Compile Details Tab, 71, 72

compile warnings and errors, 71, 72

compiling projects

 overview, 71

 using ControlIT, 63, 72

 using DesignIT, 71

conditional action buttons, 38

 applying presets, 39

 creating presets, 39

 removing programming, 39

ConfigureIT

 overview, 66

 starting and exiting, 66

 viewing or modifying scene values, 67

control station devices

 adding, 18

 enabling or disabling, 59

 programming buttons for, 35

 removing, 18

 viewing the state of, 59

 virtually pressing a button, 59

control stations

 adding, 17

 creating multiple, 17

 enabling or disabling, 96

 renaming, 17

 viewing the state of, 96 

 working with, 35

ControlIT

 basic operations, 53

 Details tab, 55

 Navigation Tree, 54

 overview, 53

 page components, 53

 starting and exiting, 53

 system transfer function, 73

 tabs and subtabs, 54

controlling the system, 56

Control system

 starting or stopping a service, 77

 starting, 77

 troubleshooting, 78

 viewing the status of, 77

 converting fixed spaces to partitionable spaces, 16

 converting partitioned spaces to fixed spaces, 17

D
DataLogging, 63, 76

Database

 backup, 69

 restore, 70, 77

 update, 70

date-specific schedules, 43

default weekly schedules, 44

deleting objects, 10

deleting users, 49

DesignIT

 basic operations, 7

 deleting objects, 10

 framework, 7

 navigator, 8, 9

 opening screens, 8

 overview, 7

 screen components, 8

 starting and exiting, 7

 toolbar, 8

Detailed overview page, 57

Details tab, 55

diagnostic tests, 65

disabling users, 50

dual action buttons, 37

E
editing object properties, 10

eLumen

 overview, 1

 application software tools, 1

emergency level, 58

enclosures, 26

 renaming, 26

Equipment Definition screen, 25

events

Ind
ex



 adding astronomic, 42

 adding real time, 43

 changing time of, 43, 46

exiting ConfigureIT, 66

exiting ControlIT, 53

exiting DesignIT, 7

exiting SecureIT, 48

F
fixed spaces

 converting partitioned spaces to, 17

 converting to partitionable spaces, 16

 creating, 12

flashing, zone, 58

frequently asked questions, 6

G
generating reports, 46, 64

glossary, see lexicon

GRAFIK lighting control system, 1

 sample system, 2

Group Definition screen, 31

groups, 31

 applying a mode, 62

 assigning objects, 32

 creating, 31

 renaming, 31

 viewing group details, 62

 viewing the state of, 62

H
help, 5

hiding the Details tab, 55

high-end trim, 58

I
intensities

 adjusting in a zone, 57, 58

 setting in a zone, 57

 specifying for a scene, 23

 viewing, 57

IP address, 29, 75

L
 lamp info for Lighting Zone Controller units, 65

lexicon, 80

light level graph, 57, 58

lighting levels, see intensities

Lighting Zone Controller (LZC) units

 afterhours mode, 58

 and powergraph, 57, 58

 and ConfigureIT, 66

 creating a sensor association, 30

 displaying lamp information, 65

 removing a sensor association, 30

 setting load shed, 58

 settings, 58

links, 28

loads, defining, 21

logging in

 ConfigureITTM, 66

 ControlIT, 53

 DesignITTM, 7

 SecureITTM, 48

Logical Definition screen, 19

low-end trim, 58

M
maintenance

 displaying lamp information for Lighting 

   Zone Controller units, 65

 running diagnostic tests, 65

Maintenance page, 65

manual, use of, 4

Mode Definition screen, 33

modeling a facility, 12

modeling partitionable spaces, 16

modes, 33

 applying to a group, 62

 applying to a movable wall, 61

 applying to a space, 56

 applying to a time clock, 60

 applying to a variable, 61

 applying to a zone, 58

 assigning objects, 34

 creating, 33

 renaming, 33

 setting values, 34

 selecting, 56, 57

Monitor & Control page, 56

monitoring the system, 56

movable walls

 applying modes, 61

 creating, 15

 opening and closing, 61

 viewing the state of, 61

 viewing wall details, 61

N
navigating through a project

 ControlIT, 54

 DesignIT, 9

navigation tree

 ControlIT, 54

 DesignIT, 9

Navigator, 8, 9

network settings, 29
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O
objects

 adding, 28

 assigning to a group, 32

 assigning to a mode, 34

 deleting, 10

 entering setting values, 34

 removing, 10, 29

 viewing and editing properties, 10

Overview page, 56

P
panels 

 adding, 26

 renaming, 26

Partitionable Space Designer, 14, 15

partitionable spaces

 converting fixed spaces to, 16

 creating, 14

 modifying, 14

 renaming, 15

 viewing, 15

partitioned spaces

 converting to fixed spaces, 17

 opening and closing movable walls, 61

 viewing the state of movable walls, 61

password, 49

power graph, 57, 95

preferences

 specifying settings, 63

 viewing and setting, 63

preset lighting scenes

 changing for individual zones, 23

 changing for multiple zones, 23

presets

 applying, 39

 creating, 39

processors

 adding, 26

 adding objects to links, 28

 configuring networking settings, 29

 pinging, 75

 removing objects from, 29

 renaming, 26

programmable devices

 applying a mode, 59

 enabling or disabling, 59

 viewing details, 59

 viewing the state of, 59

 virtually pressing a button, 59

programming buttons

 conditional action, 38

 dual action, 37

 single action, 35

programming for schedules

 assigning objects, 41

 creating, 41

Programming screen, 35

projects

 associating with users, 50

 compiling in ControlIT, 63, 72

 compiling in DesignIT, 71

 creating, 11

 renaming, 11

 transferring, 106

Properties box, 8, 10, 11

 viewing and editing properties, 10

R
real-time events, 43

removing objects, 10

renaming partitionable spaces, 13

renaming projects, 11

reports, 64

RS232, 72

Runtime Logic System, 76, 77

 starting, 78

 troubleshooting, 78 

S
scene capture macro, 62

scenes

 adding zones, 22

 adjusting zone values in a scene, 68

 changing settings, 23

 creating, 22

 creating multiple, 22

 making a scene active, 67

 removing zones from, 22

 renaming, 22 

 saving modified values, 68

 selecting in a space, 56, 57

 viewing or modifying scene values, 67

schedules

 adding astronomic events, 42

 adding date-specific schedules, 43

 adding default weekly schedules, 44

 adding real-time events, 43

 adding to time clocks, 43, 44

 assigning objects and actions, 41

 changing event time, 43

 creating, 42

 creating new programming, 41   

    planning, 40

 renaming, 42

 viewing the schedule for a date, 44, 45



 working with, 40

screen components

 ControlIT, 53

 DesignIT, 7

 SecureIT, 1, 48

 overview, 48

 starting and exiting, 48

selecting scenes

 from ConfigureIT, 67

 from Detailed Overview page, 57

 from Overview page, 56

sensors

 adding, 18

 associating with LZC units, 30

 creating multiple, 18

 removing an association, 30

 renaming, 18

settings for LZC units, 58

showing the Details tab, 55

single action buttons, 35

spaces

 applying modes, 56, 57

  converting fixed spaces to partitionable spaces, 16

  converting partitioned spaces to fixed spaces, 17

 creating fixed spaces, 12

 creating partitionable spaces, 14

 light level graph, 57, 58

 overview, 12

 Partitionable Space Designer, 15

 power graph, 57, 58

 renaming partitioned spaces, 15

 selecting scenes, 56, 57

 setting the load shed (LZC), 58

  viewing in detailed system overview, 56, 57

 viewing in system overview, 56

starting ConfigureIT, 66

starting ControlIT, 53

starting DesignIT, 7

starting SecureIT, 48

status, 58

subnet mask, 29

switch leg controls

 associating with switch legs, 27

 removing sensor associations, 30

 removing switch leg associations, 27

switch legs

 adding, 19

 associating with switch leg controls, 27

 associating with zones, 20

 creating multiple, 19

 defining loads, 21

 renaming. 19

System Definition screen, 11

system maximums, 3

System Settings page, 63

System Services

 control system, 76, 77

 overview, 76

 Runtime Logic System, 78

system transfer, 73

T
tabs and subtabs in ControlIT, 54

technical support, 5

time clocks

 adding date-specific schedules, 43

 adding default weekly schedules, 44

 applying a mode, 60

 changing existing programming, 47

 changing single action to conditional, 47

 changing the day of an event, 46

 changing the time of an event, 46

 creating, 25

 editing actions from programming, 47

 enabling or disabling, 60

 errors, causes, 73

 planning configurations of, 40

 re-enabling at midnight, 60

 removing actions from programming, 47

 renaming, 25

 viewing details, 60

 viewing schedules, 60

 viewing the state of, 

 working with, 40

toolbar, 8

transfer details, 73

transfer troubleshooting, 75

transferring projects, 71, 73-75

 troubleshooting. See frequently asked questions

U
UI port, 29

unit address, 29

users

 user accounts, 48

 user locale, 49

 adding users, 49

 associating users with projects, 50

 changing basic information, 51

 deleting users, 49

 disabling users, 50

 enabling users, 50

 name, 49

 removing a project association, 50

 resetting passwords, 51

 setting access to spaces, 52

 setting application features access, 52

 setting application level access, 52

user information, changing, 51
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user passwords, resetting, 51

user privileges

 modifying, 51

 viewing, 57

using your manual, 4

V
variable states

 creating, 24

 creating multiple, 24

 setting, 61

variables

 applying a mode, 61

 creating, 24

 creating multiple, 24

 creating variable states, 24

 renaming, 24

 setting the variable state, 61

 viewing the state of, 61

 viewing variable details, 61

W
wall control state, 58

warnings and errors, transfer, 75

weekly default schedules, 75

Z
zones

 adding to scenes, 20, 22

 adjusting values in a scene, 68

 Afterhours mode, 58

 applying modes, 58

 creating, 20

 creating multiple, 20

 LZC unit settings, 58

 light level graph, 57, 58

 modifying sensor settings (LZC), 58

 power graph, 57, 58

 raise or lower zone intensity, 57, 58, 68

 removing from scenes, 22

 renaming, 20

 setting the load shed (LZC), 58

 starting or stopping flashing, 58

 switch leg associations, 20

 turning a zone ON or OFF, 58

 turning all zones ON or OFF, 58

 viewing and setting intensities, 57

 viewing or modifying scene values, 67

 viewing power and light levels, 57, 58

 viewing zone details, 58
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